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お客様へのご注意 ソリッドステート機器はエレクトロメカニカル機器とは動作特性が異なりま
す。さらにソリッドステート機器はいろいろな用途に使われることからも、
この機器の取扱責任者はその使用目的が適切であるかどうかを充分確認して
ください。この機器の使用によって何らかの損害が生じても当社は一切責任
を負いません。詳しくは、パブリケーション・ナンバー SGI-1.1『ソリッ
ド・ステート・コントロール　ソリッドステート装置のアプリケーション、
設置、および保守のための安全ガイドライン』(当社の営業所または http://
www.literature.rockwellautomation.comからオンラインで入手可能 )を参照し
てください。

本書で示す図表やプログラム例は本文を容易に理解できるように用意されて
いるものであり、その結果としての動作を保証するものではありません。
個々の用途については数値や条件が変わってくることが多いため、当社では
図表などで示したアプリケーションを実際の作業で使用した場合の結果につ
いては責任を負いません。

本書に記載されている情報、回路、機器、装置、ソフトウェアの利用に関し
て特許上の問題が生じても、当社は一切責任を負いません。

製品改良のため、仕様などを予告なく変更することがあります。

本書を通じて、特定の状況下で起こりうる人体または装置の損傷に対する警
告および注意を示します。

• トラブルが起こりうる場合

• トラブルの原因

• 不適当な操作を行なった場合の結果

• トラブルの回避方法

警告
本書内の「警告」は、人体に障害を加えうる事項、および装置
の損傷または経済的な損害を生じうる、危険な環境で爆発が発
生する可能性がある操作や事項を示します。

注意 本書内の「注意」は正しい手順を行なわない場合に、人体に障
害を加えうる事項、および装置の損傷または経済的な損害を生
じうる事項を示します。

重要 本書内の「重要」は、製品を正しく使用および理解するために
特に重要な事項を示します。

感電の危険 危険な電圧が存在する恐れがあることを知らせるために装置の
上または内部にラベルを貼っています。

やけどの危険表面が危険な温度になっている恐れがあることを知らせるため
に装置の上または内部にラベルを貼っています。



重要：ソフトウェアをご利用の場合は、データの消失が考えられますので、
適当な媒体にアプリケーションプログラムのバックアップをとるこ
とをお奨めします。

重要：本製品を日本国外に輸出する際、日本国政府の許可が必要な場合が
ありますので、事前に当社までご相談ください。

本版は、1753-PM001A-EN-P - November, 2005の和訳です。
1753-PM001A-EN-Pを正文といたします。

GuardPLCは、Rockwell Automation, Inc.の商標です。

Modbusは、Schneider Automation, Inc.の登録商標です。

DeviceNetは、Open DeviceNet Vendor Associationの商標です。

Rockwell Automationに属さない商標は、それぞれの企業に所有権があります。

EC (欧州連合 )の規格
への準拠

本製品に CEマークがある場合は、欧州連合 (EU)および EFA地域内での使
用が承認されています。以下の規則に適用するように設計されテストされて
います。

EMC指令

この製品は、理事会規制 89/336「電磁適合性 (EMC)」および以下の規格の、
技術解説ファイルに記載された内容に完全にまたは部分的に準拠することを
テストで確認済みです。

• EN 50081-2 EMC：一般的な放射規格、パート 2 - 産業環境

• EN 50082-2 EMC：一般的なイミュニティ規格、パート 2 - 産業環境

この製品は、産業環境での使用を目的としています。

低電圧指令

この製品は、EN 61131-2「プログラマブルコントローラ、パート 2：機器の
必要条件およびテスト」の安全事項を適用することによって、理事会規制
73/23/EEC「低電圧」に準拠することをテストで確認済みです。EN 61131-2
に要求される特定の情報については、このマニュアルの対応する項を参照す
るか、ノイズ防止については『配線および接地に関するガイドライン』 (Pub. 
No. 1770-4.1)を参照してください。

この装置は開放型の装置と分類されており、安全保護の手段として、動作時
は筐体内に設置 (取付け )しなければなりません。





変更内容

ここには、前回のマニュアル以降からの新情報と改訂情報をまとめて示しま
す。

本マニュアルでは、追加情報と改訂情報の検索を簡単に行なうことができる
ように、このパラグラフの右のような改訂バー (変更箇所表示線 )を入れて
います。

プログラミングと構成手順および例については、『GuardPLCコントローラ
システム　ユーザーズマニュアル』 (Pub.No. 1753-UM001)から抽出して、こ
のプログラミングマニュアルに再構築しました。さらに、以下の表に示すよ
うに新規と更新情報が追加されています。

内容 参考箇所

GuardPLCコントローラと分散 I/Oモジュールのハード
ウェア、取付け、配線、および通信の説明 

GuardPLCコントローラシ
ステム　ユーザーズマニュ
アル (Pub.No. 1753-UM001)

本マニュアルの目的 P-1ページ

参考資料 P-1および P-2ページ

新しいコントローラとの通信が失敗した場合にすべき
こと

1-20ページ

GuardPLC分散 I/Oモジュールへの接続 第 2章

Signal Editorの理解 3-5ページ

分散 I/Oモジュール信号の接続 3-10ページ

アナログ信号の接続 3-11ページ

ハイスピードカウンタ信号の接続 3-12ページ

FAILURE_STOPからの回復 4-2ページ

プロジェクトのアーカイブおよびリストア 第 7章

変数に有効なデータタイプ 8-4ページ

プログラミングソフトウェアのバージョン、互換性、
およびファームウェアアップグレード

付録 A

異なるソフトウェアバージョンで開発されたプロジェ
クトの変換

A-5ページ

時間ベースの変数の作成 付録 C
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はじめに

対象読者

このマニュアルは、GuardPLCコントローラを使用する制御するシステムの
設計、取付け、プログラミング、またはトラブルシューティングを行なう方
がご利用ください。

安全関連コントローラの設置、プログラミング、操作、およびトラブル
シューティングの責任者は、Programmable Electronic Systems (PES：プログ
ラマブル電子システム )に関する安全規格を熟知していることが必要です。

本マニュアルの目的

このマニュアルには、コントローラシステムのプログラミング (プログラミ
ングターミナルと GuardPLCコントローラとの間の通信の確立、GuardPLC
プロジェクトの作成、プロジェクトへの GuardPLC分散 I/Oの追加、および
ユーザ定義ファンクションブロックの作成を含む )の作業手順を記載してい
ます。

GuardPLCコントローラシステムの取付け、構成、動作、およびステータス
のモニタについては、『GuardPLCコントローラシステム　ユーザーズマ
ニュアル』(Pub.No. 1753-UM001)を参照してください。

このマニュアルでは、SIL 3またはカテゴリ 4安全アプリケーション要件に
ついての情報は記載していません。コントローラの中心的な機能、入力と出
力チャネル、オペレーティングシステム、アプリケーションプログラムの安
全および使用に関する規格を含む、GuardPLCコントローラに関する安全ポ
リシーについては、『GuardPLC Controller Systems Safety Reference Manual』
(Pub.No. 1753-RM002)を参照してください。

参考資料

次のページに示す表に、ロックウェル・オートメーションの GuardPLC製品
に関する更なる情報を記載するドキュメントをリストしています。

このコピーは以下の方法で入手してください。

• インターネットで以下のアドレスからフリーの電子バージョンをダウン
ロードします：www.rockwellautomation.com/literature

• 印刷されたマニュアルを購入するには、当社または代理店に問い合わせ
てください。
Pub.No. 1753-PM001A-JA-P



P-2 はじめに
内容 マニュアル名 Pub. No.

GuardPLCコントローラ用の DeviceNet Safetyス
キャナを含む GuardPLCコントローラシステム
の安全概念に関する詳細な説明

GuardPLC Controller Systems Safety Reference Manual 1753-RM002

GuardPLCコントローラシステムの取付け、構
成、動作、およびステータスのモニタに関する
説明

GuardPLC Controller Systems User Manual
(GuardPLCコントローラシステム　ユーザーズマ
ニュアル )

1753-UM001

GuardPLCアプリケーションでの DeviceNet 
Safety スキャナの取付け、構成、および動作に
関する説明

DeviceNet Safety Scanner for GuardPLC Controllers 
User Manual

1753-UM002

1791DS DeviceNet Safety I/Oモジュールの動作に
関する説明

DeviceNet Safety I/O User Manual (DeviceNet Safety I/O 
モジュール　ユーザーズマニュアル )

1791DS-UM001

GuardPLC安全アプリケーションでの認可された
ファンクションブロックの使用に関する説明

GuardPLC Certified Function Blocks Safety Reference 
Manual

1753-RM001

アレン・ブラドリーのプログラマブルコント
ローラの接地と配線に関する詳細な説明

Industrial Automation Wiring and Grounding Guidelines
(接地および配線に関するガイドライン )

1770-4.1

ソリッドソテートのプログラマブルコントロー
ラ製品とハード配線された電気機械式デバイス
間の重要な相違点の説明

Application Considerations for Solid-State Controls 
(ソリッドステート装置のアプリケーション、設置、
および保守のための安全ガイドライン )

SGI-1.1

電気機器の接地線の種別とサイズの規定 National Electrical Code (全米電気綱領：NEC)：米国防火協会 (National 
Fire Protection Association, Boston, MA)発行 

産業用オートメーションの用語と略語集 Allen-Bradley Industrial Automation Glossary (産業
オートメーション用語集　技術用語ガイド )

AG-7.1
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第 1章

GuardPLCコントローラへの接続

1.1 本章の内容

1.2 RSLogix Guard PLUS!ソフトウェアを使用するコントローラへの接続

コントローラの Ethernetポートを使用して、コントローラをプログラミング
ターミナルに接続します。プログラミングターミナルには、Ethernetポート
または Ethernet通信カードが必要です。

プログラミングターミナルをコントローラに直接接続するときは、クロス
オーバ Ethernetケーブルを使用します。GuardPLC 1600および 1800コント
ローラには自動検知ポートが装備されているため、クロスオーバまたはスト
レートスルーケーブルを使用できます。

1.2.1 GuardPLC 1200コントローラへの接続

内容 参照ページ

RSLogix Guard PLUS!ソフトウェアを使用するコントローラへの接続 1-1

GuardPLCコントローラに対してオンラインにする 1-5

プログラミングターミナルの構成 1-18

Loginダイアログ 1-19

コントローラの IPアドレスおよび SRSの決定 1-20

コントローラの SRSの変更 1-21
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1-2 GuardPLCコントローラへの接続
1.2.2 GuardPLC 1600または 1800コントローラへの接続

1.2.3 GuardPLC 2000コントローラへの接続

1.2.4 GuardPLCコントローラの工場出荷時のデフォルト設定

パラメータ 設定

IP Address (IPアドレス ) 192.168.0.99

Subnet Mask (サブネットマスク ) 255.255.252.0

SRS(1)

(1) SRSコードはプログラムでコンパイルされます。プログラムは、不揮発性メモリに格納され
た対応する SRS のある GuardPLCコントローラにのみダウンロードできることを保証しま
す。
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GuardPLCコントローラへの接続 1-3
1.2.5 Ethernetアドレス指定について

Ethernet上のデバイス間のコネクションと同様に、IPアドレスとサブネット
マスクによってコネクションを行なうかが決まります。Ethernet上のデバイ
スはすべて IPアドレスとサブネットマスクを持っています。

IPアドレスとサブネットマスクは 4つの 8ビット (001.002.003.004)で構成
されています。IPアドレスは、ネットワーク ID (8ビットの 001と 002)お
よびホスト ID (8ビットの 003と 004)から構成されています。IPアドレス
のネットワーク ID部分は、サブネットマスクから派生します。

2つのデバイスが Ethernetで会話しようとすると、発信者と宛先アドレスの
両方のネットワーク IDが一致しているかがチェックされます。一致してい
るときは、メッセージはローカルネットワークに送信されます。一致してい
ないときは、メッセージはゲートウェイに送信され、さらに宛先まで送られ
ます。ローカルネットワーク上のすべてのデバイスのサブネットマスクは同
じでなければなりません。

以下の例に、GuardPLCコントローラの IPアドレスとサブネットマスクのデ
フォルトに基づいてどのようにネットワーク IDが派生するかを示します。

例 ネットワーク IDの決定

デフォルト設定：
IPアドレス 192.168.0.99  = 11000000 . 10101000 . 00000000 . 01100011
サブネットマスク 255.255.252.0  = 11111111 . 11111111 . 11111100 . 00000000
ネットワーク ID  = 11000000 . 10101000 . 000000xx . xxxxxxxx

GuardPLCコントローラと同じネットワーク IDになるように、プログラミ
ングターミナルの IPアドレスをセットアップします。サブネットマスクの
8ビット 1と 2が 255であるため、8ビット 1と 2を同じにする必要があり
ます。3番目のサブネットマスク の 8ビットは 252で、最後の 2ビットの
みが異なることを意味します。

上記の工場出荷時のデフォルト設定を使用しているときは、RSLogix Guard 
PLUS!ソフトウェアが稼動しているプログラミングターミナルに許容可能
な IPアドレスは以下のようになります。

•  192.168.0.xxx  (xxxは 000～ 255の任意の値を示す。)

• 192.168.1.xxx

• 192.168.2.xxx

• 192.168.3.xxx
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1-4 GuardPLCコントローラへの接続
1.2.6 プログラミングターミナルの IPアドレスの構成

GuardPLCコントローラとプログラミングターミナルがローカルネットワー
クで通信できるように、RSLogix Guard PLUS!ソフトウェアが稼動している
プログラミングターミナルの IPアドレスを変更してください。

以下の手順に従って、IPアドレスを変更してください。

1. Windows 2000で、Start→ Setting→ Control Panel→ Network and Dial-up 
Connectionsを順に選択します。

2. Local Area Connectionsを開いて、Propertiesをクリックします。TCPIPを
選択してから Propertiesをクリックします。

3. General TCP/IP Propertiesを以下に示すように設定します。

4. 両方のダイアログボックスで OKをクリックして、設定を確定します。

重要 コントローラに始めて接続するときは、工場出荷時に設定され
た IPアドレスである 192.168.0.99と、デフォルトの SRSであ
る 60000を使用する必要があります。コントローラとの通信を
確立した (以降のページに説明する手順を使用して )後で、
Ethernetネットワークをより適合させるために IPアドレスおよ
び SRSを変更できます。

ヒント GuardPLCコントローラが工場出荷時に設定されたデフォルト
である 192.168.0.99の IPアドレスと、デフォルトである
255.255.252.0のサブネットマスクであるかわからないときは、
通信を確立するために、プログラミングターミナルの IPアド
レスを 192.168.0.98に、サブネットを 255.255.252.0に設定しま
す。
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GuardPLCコントローラへの接続 1-5
1.3 GuardPLCコントローラに対してオンラインにする

以下のフローチャートに、GuardPLCコントローラに対してオンラインにす
るために必要な手順を示します。

手順は、以降のセクションで詳細に説明します。

ステップ 1: RSLogix 
Guard PLUS!を起動
する。

すでに設定を
知っているか ?

FAULT LEDが
点灯しているか ?

コントローラ
設定を知っている

か ?

通信設定が
IP/SRSの読取りに
成功したか ?

コントローラの
これらの設定を変更

したいか ?

コントローラが
ランモードですか ?

Pingが
成功したか ?

正しい設定で
オンラインになって

いるか ?

YES

YES

YES

YES

YES

YES

YES

YES

NO

NO NO

NO

NO

NO

NO

ステップ 2: 新しいプ
ロジェクトを作成す
る。

ステップ 3:コント
ローラのタイプと
SRSを構成する。

ステップ 12: リセット
後のフォルト回復

ステップ 4: 
通信の設定

ステップ 8:コント
ローラのモードを
STOPに変更する。

ステップ 9:コント
ローラのデフォルト設
定にリセットする。(2)

ステップ 6: 設定をオ
フラインプロジェク
トに移動する。

ステップ 7: Control 
Panelを使用してコン
トローラを接続する。

ステップ 5: MACア
ドレスから設定を変
更する。

ステップ 10:コント
ローラの Ping

ステップ 11:コント
ローラの IP アドレス
を構成する。(1)

注：
(1) 正しい SRSがステップ 3で入力されたと仮
定する。

(2) 次の電源切断後の投入の前に再構成されない
ときは、コントローラは前の設定に戻る。

(3) コントローラがすでに実行していて SRSが 
ステップ 5で変更されたとき、またはコント
ローラが新しい (初期状態 )ときは、フォル
トをクリアする唯一の方法は対応する SRS
があるプログラムをダウンロードすることで
す。

完了 (3)

注：このパスは GuardPLC 1200
および GuardPLC 2000コント
ローラでは使用できない

NO
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1-6 GuardPLCコントローラへの接続
1.3.1 ステップ 1:  RSLogix Guard PLUS!ソフトウェアの起動

Start→ Programs→ RSLogix Guard PLUS→ RSLogixGuardPLUSを順に選択し
ます。

1.3.2 ステップ 2:新規プロジェクトの作成

既存のプロジェクトを開くか、または GuardPLCコントローラを含む新しい
プロジェクトを作成します。

1. 新しいプロジェクトを作成するには、メインメニューから Project→ New
を順に選択するか、または Newアイコンをクリックします。

2. Object Nameフィールドにプロジェクトの名前を入力します。

3. OKをクリックします。
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GuardPLCコントローラへの接続 1-7
RSLogix Guard PLUS! Hardware Managementウィンドウが開きます。RSLogix 
Guard PLUS!ソフトウエアが稼動しているときは、Project Managementと
Hardware Managementの両方のウィンドウが通常開きます。

1.3.3 ステップ 3:コントローラタイプおよび SRSの構成

オンラインにするには、コントローラのタイプを指定して、デフォルトの
SRSを変更する必要があります。ソフトウェアでは SRSを 0にデフォルト
設定していますが、これは誤った SRS値です。コントローラタイプを受入
れるには、SRSを 2(1)～ 65535の値に変更する必要があります。

1.  [0] Resourceが表示されるまで、Hardware Managementウィンドウでプロ
ジェクトツリーを展開します。

2. [0] Resourceを右クリックして、Propertiesを選択します。

(1) プログラミングターミナルのデフォルトは 1です。
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1-8 GuardPLCコントローラへの接続
3. コントローラタイプを指定して、SRSに 60000を入力します。

GuardPLCコントローラに始めて接続するときは、デフォルトの SRSで
ある 60000を使用する必要があります。

4. OKをクリックします。

Hardware Managementウィンドウは以下のように表示されます。SRSが
60000に変更されていることに注意してください。
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GuardPLCコントローラへの接続 1-9
1.3.4 ステップ 4: 通信の設定

1. プルダウンメニューから Online→ Communication Settingsを順に選択し
ます。

2. MAC AddressフィールドにMACアドレスの最後の 3エレメントを入力
して、Getをクリックします。

MACアドレスは、GuardPLC 1200コントローラの側面のステッカー、
GuardPLC 1600/1800コントローラと I/Oの下方の RJ-45コネクタ上にあ
るラベル、または GuardPLC 2000コントローラの AB-CPUモジュールの
フロントベゼルに記載されています。

GuardPLCコントローラの IPアドレスおよび SRS が、Address PES 
using…フィールドに表示されるはずです。

ヒント 通信が失敗するときは、ファイヤウォールまたはセキュリ
ティ設定を無効にする必要があることがあります。
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1-10 GuardPLCコントローラへの接続
1.3.5 ステップ 5: MACアドレスを使用する設定の変更

1. 以下の矢印が示す Communication Settingsフィールドに、IPおよび SRS
の希望する設定を入力します。

2. Set via MACボタンをクリックします。

3. 以下に示すように Authenticationウィンドウにデフォルトのユーザ名であ
る ‘Administrator’を入力します。

4. OKをクリックします。
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GuardPLCコントローラへの接続 1-11
IPアドレスおよび SRSが変更されたはずです。プロンプトがウィンドウの
一番下に表示され、中央のフィールドの設定が変更されます。
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1-12 GuardPLCコントローラへの接続
1.3.6 ステップ 6: オフラインプロジェクトへの設定の移動

現在の GuardPLCコントローラ設定を使用して接続したいときは、設定をオ
フラインプロジェクトに移動します。

1. 左クリックしてから、Projectを選択します。

2. Resourceが Resource Selectionウィンドウで選択されていることを確認し
て、OKをクリックします。

3. Yesをクリックします。

これによって、GuardPLCコントローラの IPアドレスおよび SRSがオフラ
インプロジェクトに移動して、既存の値が上書きされます。これらの新しい
値は、GuardPLCコントローラに接続するログイン画面で使用されます。
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GuardPLCコントローラへの接続 1-13
1.3.7 ステップ 7: Control Panelを使用する GuardPLCコン
トローラへの接続

1. [60000] Resourceを右クリックします。

2. Online→ Control Panelを順に選択します。

3. [Ctrl]+[A]を押して、デフォルトのユーザ名、パスワード、およびアクセ
スタイプを Loginウィンドウに記入します。

4. OKをクリックします。

コントローラがランモードのときは、Control Panelの Onlineインジケータが
緑色になります。Onlineインジケータは、現在の状態に基づいて黄色、白
色、または赤色になることもあります。

ヒント GuardPLCコントローラとオンラインにして、ランモード (上
図に示すように緑色の Onlineインジケータ )にできたときは、
ステップ 8～ 12を続ける必要はありません。ただし、オンラ
インにできなかったか、ランモードにできなかったときは、
1-5ページのフローチャートを参照して適切な手順を行なって
ください。
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1-14 GuardPLCコントローラへの接続
1.3.8 ステップ 8:コントローラの停止モードへの変更

コントローラを停止モードに変更するためには、Control Panel から Resource
→ Stopを順に選択しするか、または Stopアイコンを使用します。

停止モードのときは、Control Panelが以下に示すように表示されます。

Control Panelを選択します。

1.3.9 ステップ 9:コントローラのデフォルト設定へのリセット

場合によって、GuardPLCコントローラをそのデフォルト IPアドレスと SRS
にリセットする必要があることがあります。

GuardPLC 1600および 1800コントローラには、コントローラの上面にある
Ethernetポートのすぐ右の小さな穴からアクセスできるリセットボタンがあ
ります。リセットボタンを押すと、IPアドレス、SRS およびパスワードが
以下の設定に戻ります。

以下の手順に従って、コントローラをリセットしてください。

1. リセットボタンを押したままにして、GuardPLCコントローラの電源を切
断後再投入します。

2. PROG LED の点滅が停止するまで、リセットボタンを押し続けます。

設定は、次に電源を投入したときに最後に構成した設定に戻ります。コント
ローラをリセットした後に再構成を行なっていないときは、リセット動作を
行なう前の設定になります。

パラメータ 設定

IP Address (IPアドレス ) 192.168.0.99

SRS 60000

Username (ユーザ名 ) Administrator

Password (パスワード ) [none]
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GuardPLCコントローラへの接続 1-15
1.3.10 ステップ 10:コントローラの Ping

Startメニューを使用して、RSLogix Guard PLUS! Command Promptを開いて
ください。

1. Start→ Programs→ RSLogix Guard PLUS→ RSLogix Guard PLUS Command 
Promptを順に選択します。

2.  DOSコマンドのプロンプトに Run IPCONFIGを入力して、コンピュータ
の IPアドレスを確認します。GuardPLCコントローラと同じローカル
ネットワークでなければなりません。

3. 以下に示す C:\>コマンドを使用して、GuardPLCコントローラを Pingし
ます。Ping が成功すると、GuardPLCコントローラの IPアドレスの妥当
性と Ethernetリンクが動作しているかを確認できます。Ping が成功しな
かったときは、IPアドレス、サブネットマスク、または Ethernetリンク
のいずれかが誤っています。以下の図に、Pingが成功した場合を示しま
す。

4. コマンドプロンプトに EXITを入力して、Command Promptウィンドウを
閉じます。
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1-16 GuardPLCコントローラへの接続
1.3.11 ステップ 11: GuardPLCコントローラの IPアドレスの
構成

1. コントローラの COMアイコンが表示されるまで、Hardware Management
ウィンドウでプロジェクトツリーを展開します。

2. COMを右クリックしてから、Propertiesを選択します。

3. GuardPLCコントローラと一致するように IPアドレスを編集してから、
OKをクリックします。
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GuardPLCコントローラへの接続 1-17
1.3.12 ステップ 12: リセットボタンを使用した後のコント
ローラフォルトからの回復

リセットする前に SRSがオリジナルの 60000ではないときは、リセットボ
タンを使用した後に Control Panelは以下のように表示されます。GuardPLC
コントローラの前面にある Fault LEDが点灯し、Resourceの CPU Stateが
STOP/INVALID CONFIGURATIONになります。

以下の手順に従って、このフォルトから回復してください。

1. Control Panelから、Extra→ Change System IDを順に選択します。

2. 以下に示すように、最初のウィンドウに 60000 が、2番目に 0が表示さ
れることを確認します。

3. OKをクリックします。
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1-18 GuardPLCコントローラへの接続
Fault LEDが消灯し、Control Panelでは以下に示すように CPU Stateが
STOP/VALID CONFIGURATIONに変更されるはずです。

1.4 プログラミングターミナルの構成

1.4.1 ホスト SRSの指定

Hardware Managementウィンドウから、プログラミングターミナルのホスト
SRSを指定できます。

1. Programming Terminalを右クリックしてから、Propertiesを選択します。

2. プログラミングターミナル用のホスト SRS (1～ 65535)を入力します。

プログラミングターミナルの ホスト SRSが他のコントローラまたはプログ
ラミングターミナルのシステム ID (SRS) と同じでないことを確認します。

ネットワークでは、最大 5台のプログラミングターミナルを同じコントロー
ラに同時に接続できます。ただし、Read/Write (読取り /書込み )アクセスで
きるのは 1台のプログラミングターミナルのみです。

ヒント GuardPLCコントローラが STOP/VALIDモードであるため、
Onlineインジケータは白色です。
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GuardPLCコントローラへの接続 1-19
他のコントローラが Read (読取り )アクセスでログインしているときは、そ
の追加のユーザはコントローラの状態とパラメータ (RUN, STOP,コントロー
ラツスイッチなど )を Control Panelから検索できます。また、追加のユーザ
は、プログラミングターミナルがコントローラと同じ構成のときは、データ
値を見ることもできます。

1つのネットワーク上に複数プログラミングターミナルがあるときは、プロ
グラミングターミナルごとに固有のホスト SRSが必要です。

1.5 Loginダイアログ

Loginダイアログでは、コントローラとプログラミングターミナルとの間の
通信パラメータを定義します。

フィールド 説明

IP address Ethernetネットワーク上のコントローラの IPアドレス。
工場出荷時に設定された IPアドレスは、192.168.0.99です。

SRS SRSは、システム、ラック、スロットの略です。ラックとスロット IDはコントローラ
に設定済みであるため、システム IDのみ入力する必要がある。1～ 65,535の値を入力
できる。ただし、番号は、プログラミングターミナルからと、同じピア・ツー・ピア
Ethernet上の他の GuardPLCコントローラから固有でなければならない。
デフォルト (工場出荷時に設定 ) SRSは、60000です。

Username
(デフォルト = Administrator)

ユーザ名
Administratorがユーザ名を割付ける。ユーザ名は大文字と小文字を区別する。ユーザ名
として使用できるのは、文字、数字、およびアンダースコア (_)文字のみです。
GuardPLCコントローラ 1台当たり最大 10のユーザ名を定義できる。

Password
(デフォルト = <blank>)

パスワード
Administratorがパスワードを割付ける。パスワードは大文字と小文字を区別する。パス
ワードに使用できるのは、文字、数字、およびアンダースコア (_)文字のみです。

Access Type アクセスレベル
以下のオプションの 1つでログインする。
Administrator 最高の特権

ユーザ名とパスワードを管理する。
コントローラからデータを読取る。
コントローラにルーチンとデータを書込む。
タグを強制する。
ルーチンを停止、始動、フリーズ、および強制する。
オペレーティングシステムをダウンロードする。
IPアドレスとシステム IDを変更する。
コントローラをリブートする。
read/writeと readレベルでもログインできる。

Read/Write コントローラからデータを読取る。
コントローラにルーチンとデータを書込む。
タグを強制する。
ルーチンを停止、始動、フリーズ、および強制する。
readレベルでもログインできる。

Read 最低の特権
できるのはコントローラからデータを読取ることのみ

最大 5人のユーザが同じコントローラに同時にログインできるが、Administratorまたは
Read/Writeとしてログインできるのはこれらのユーザのうち一人だけです。他は Read
アクセスでログインする必要がある。誰かが Administratorまたは Read/Writeアクセス
でロングインしているときにログインすると、選択したアクセスタイプに関係なく自
動的に Readアクセスになる。
新しいコントローラの場合、バックアップバッテリを GuardPLC 1200または 2000コン
トローラから外すと、以下のシステムデフォルトを使用してアクセスできる。
Username: Administrator
Password <blank>
Access Type Administrator
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1.6 コントローラの IPアドレスおよび SRSの決定

新しいコントローラのデフォルトの IPアドレスは、192.168.0.99です。新し
いコントローラのデフォルトの SRSは、60000です。以下の手順に従って、
コントローラの現在の IPアドレスと SRSをチェックしてください。

1. Online→ Communication Settingを順に選択します。

2. MAC addressフィールドにコントローラのMACアドレスを入力します。

MACアドレスは、GuardPLC 1200コントローラの側面のステッカー、
GuardPLC 1600/1800コントローラと I/Oの下方の RJ-45コネクタ上にあ
るラベル、または GuardPLC 2000コントローラの AB-CPUモジュールの
フロントベゼルに記載されています。

3. Getをクリックします。

コントローラは、現在使用している IPアドレスと SRSを返します。

ヒント 通信が失敗するときは、以下を行なってください。

• 正しいアドレスを入力しているか確認する。

• PCが適切に構成されているかチェックする。

• アンチウィルスまたはファイヤウォールプログラムが通信
をブロックしている。

• ケーブルが接続されていないか、または正しいケーブルで
はない。

- GuardPLC 1600または 1800コントローラは、標準または
クロスオーバケーブルを使用できる。

- GuardPLC 1200または 2000コントローラは、PC からコ
ントローラに直接接続するクロスオーバケーブルを使用
するか、またはスイッチやハブに接続する標準ケーブル
を使用する。

• ハードウェア (コントローラまたは PCのいずれか ) が動作
していない。
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1.7 コントローラの SRSの変更

コントローラの SRSを変更するには 2つの方法があります。

Control Panelからの方法では、以下のように操作してください。

1. Extraメニューから Change System ID (SRS)を選択します。

2. SRSを入力します。

3. OKをクリックします。

または、1-9ページの「ステップ 4: 通信の設定」および 1-10ページの「ス
テップ 5: MACアドレスを使用する設定の変更」の手順を行なってくださ
い。

ヒント 通常、ダウンロードしたいコントローラ /ルーチンと一致する
ように GuardPLCコントローラの SRSを変更します。SRSを呼
出して実行可能にするためにコンパイルして、この .EXEが対
応する SRSのある GuardPLCコントローラにのみダウンロード
できることを確認します。
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1.8 コントローラの IPアドレスの変更

コントローラとの通信を確立した後で、Ethernetネットワークと一致するよ
うにコントローラの IPアドレスを変更できます。コントローラの IPアドレ
スの変更には 2つの方法があります。

Control Panelからの方法では、以下のように操作してください。

1. Extraメニューから Device Settingsを選択します。

2. 新しい IPアドレスを入力します。

3. OKをクリックします。

または、1-9ページの「ステップ 4: 通信の設定」 および 1-10ページの「ス
テップ 5: MACアドレスを使用する設定の変更」の手順を行なってくださ
い。

ヒント GuardPLCコントローラの新しい IPアドレスとサブネットで通
信を再度確立するためには、プログラミングターミナルの IP
とサブネットアドレスを変更する必要があることがあります。
Windowsの Control Panelの Networkセクションを使用して、プ
ログラミングターミナルの IPアドレスとサブネットマスクを
変更してください。
Pub.No. 1753-PM001A-JA-P



第 2章

GuardPLC分散 I/Oモジュールへの接続

2.1 本章の内容

この章では、分散 I/Oモジュールへのアドレス指定、構成、および接続のプ
ロセスについて説明します。GuardPLC分散 I/Oモジュールは GuardPLCコ
ントローラに「所有」されます。これによって、親のコントローラが分散
I/Oモジュールの入力と出力への信号を、コントローラのローカル I/Oに接
続する信号と同じ方法で接続できるようになります。

2.2 モジュールのアドレス指定

2.2.1 モジュールのデフォルト設定

GuardPLC分散 I/Oモジュールの初期設定を、以下の表に示します。

2.2.2 SRS (システム .ラック .スロット )

親のコントローラの SRSは、常に xxxxx.0になります。例えば、GuardPLC
コントローラのデフォルトの SRSは 60000.0になります。SRSを 25に変更
すると、コントローラの実際の SRSは 25.0になります。

分散 I/Oモジュールは、親のコントローラから SRS の最初の部分を継承し
ます。SRSの 2番目の部分を構成します。例えば、分散 I/Oモジュールのデ
フォルトの SRSは 60000.1です。モジュールがコントローラに 25のアドレ
スで所有されているときは、分散 I/Oモジュールの SRSは 25.1になります。
2番目のモジュール がコントローラに追加されると、その SRSは 25.2にな
ります。3番目のモジュールは SRS 25.3になります。

2.2.3 IPアドレス

Ethernetデバイスと同様に、分散 I/Oモジュールには固有の IPアドレスが必
要です。

内容 参照ページ

モジュールのアドレス指定 2-1

ハードウェア構成へのモジュールの追加 2-2

モジュールの構成 2-3

モジュールに対してオンラインにする 2-5

パラメータ 設定

IP Address (IPアドレス ) 192.168.0.99

Subnet Mask (サブネットマスク ) 255.255.252.0

SRS(1)

(1) SRSコードはプログラムでコンパイルされます。

60000.1
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2.3 ハードウェア構成へのモジュールの追加

以下の手順に従って、分散 I/Oモジュールを GuardPLCプロジェクトのハー
ドウェア構成に追加してください。

1. RSLogix Guard PLUS! Hardware Managementウィンドウで、Controller 
Resourceの下にある Distributed I/Oフォルダを右クリックします。

2. Newを選択してから、希望の I/Oモジュールを選択します。

Specify HH Networkダイアログが表示されます。コントローラと分散 I/O
モジュールは GuardPLC Ethernetを介して通信しているため、GuardPLC 
Ethernetネットワークを指定する必要があります。

3. New….をクリックします。

Create HH Networkダイアログが表示されます。
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4. OKをクリックします。

選択したネットワークを表示するために、Specify HH Networkウィンド
ウが再度表示されます。

5.  OKをクリックして、選択内容を確認します。

分散 I/Oモジュールがプロジェクトツリーに表示されます。

2.4 モジュールの構成

モジュール構成するときは、以下を行なう必要があります。

• I/Oプロパティの設定

• オフライン IPアドレスの構成
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2.4.1 I/Oプロパティの設定

1. RSLogix Guard PLUS! Hardware Managementウィンドウで、プロジェクト
ツリーでモジュールを右クリックしてから Propertiesを選択します。

2. SRSの 2番目の部分を構成するために Rack ID [SRS]を変更する必要があ
ります。Rack ID [SRS]値を 1に変更します。

3. OKをクリックします。

オフライン SRSはこれで 60000.1になります。60000は、上図に矢印で
示すように親のコントローラからもたらされます。

2.4.2 オフライン IPアドレスの構成

1. プロジェクトツリーでモジュールを展開します。

2. COMを右クリックしてから、Propertiesを選択します。

3. モジュールと一致するように IPアドレスを変更します。

4. OKをクリックします。

モジュールのオフライン構成が完了しました。次のセクションでは、モ
ジュールとオンラインにして、オフライン設定と一致するように IPアドレ
スと SRSを変更する方法を説明します。
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2.5 モジュールに対してオンラインにする

プログラミングターミナルと分散 I/O モジュールとの間に、ポイント・
ツー・ポイント・コネクションを作成します。このコネクションで、以下に
示す手順に従ってモジュールの IPアドレスと SRSを変更してください。

1. プロジェクトツリーでモジュールを右クリックしてから、Online→
Communication Settingsを順に選択します。

2. RJ-45コネクタ上にあるラベルに記載されているMACアドレスを入力し
ます。

3. Getをクリックします。

モジュールの IPアドレスおよび SRSが表示されます。モジュールが新
しいときは、GuardPLCコントローラと同じようにデフォルトの IPアド
レスである 192.168.0.99になります。ただし、デフォルトの SRSは
60000.1です。

4. IPアドレスおよび SRS設定を変更するには、新しいデータを
Communication Settingsフィールドに入力します。

5. Set via MACボタンをクリックします。
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6. User Nameフィールドに Administratorを入力してから、OKをクリックし
ます。

新しい IPアドレスおよび SRS設定が、Address PES using …フィールドに
表示されます。

7. Cancelボタンをクリックして、Communication Settingsダイアログを閉じ
ます。
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GuardPLCプロジェクトの作成

3.1 本章の内容

この章には、プロジェクトを作成するのに必要な以下の基本的な手順につい
てを説明します。

• 新規プロジェクトの開始

• プロジェクトおよびハードウェアの構成

• 信号の作成

• 信号の I/O端子への接続

• ファンクション・ブロック・プログラムの作成

• GuardPLCコントローラへのプログラムの保存、コンパイル、テストおよ
びダウンロード

• ルーチンのオンラインでのモニタ方法

3.2 新規プロジェクトの開始

以下の手順に従って、新しい GuardPLCプロジェクトを開始してください。

1. RSLogix Guard PLUS!ソフトウェアを起動します。

2. Newアイコンを使用するか、または Project→ Newを順に選択して、新
しいプロジェクトを作成します。

3. 以下に示すように Object Nameフィールドに ‘FirstProject’を入力してか
ら、OKをクリックします。

Hardware Managementウィンドウが開きます。このウィンドウを使用し
て、プロジェクト、コントローラ、I/O, および信号を構成できます。
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4. Project Managementウィンドウに戻り、以下の例のようになるまでプロ
ジェクトツリーを展開します。

プロジェクトを展開すると、Configurationと、Configurationの下に Resource 
(これは実際の GuardPLCコントローラ )が表示されます。Resourceの下に、
GuardPLCコントローラで実行するプログラム TypeInstanceがあります。

3.3 プロジェクトおよびハードウェアの構成

3.3.1 コントローラリソースの構成

1. Hardware Managementウィンドウで、以下に示すように Configuration, 
Resource, および TypeInstanceが表示されるまでプロジェクトツリーを展
開します。

2. [0] Resourceを右クリックしてから、Propertiesを選択します。

ヒント Configurationを右クリックするか、または New→ Resourceを
順に選択して、追加のコントローラをプロジェクトに追加でき
ます。
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3. 以下に示すようにプロパティを編集します。

Resource Typeは、接続したい GuardPLCコントローラのタイプと一致し
ていることが必要です。SRSはコードで、ファンクション・ブロック・
ルーチンでコンパイルされます。ルーチンは、不揮発性メモリに格納さ
れた SRSコードと一致する GuardPLCコントローラにのみダウンロード
できます。コントローラの構成については、『GuardPLCコントローラシ
ステム　ユーザーズマニュアル』(Pub.No. 1753-UM001)のコントローラ
構成の章を参照してください。

4. Applyをクリックして、これらの値をプロジェクトに移動します。

5. 4つのチェックされていないボックスをチェックしてから、OKをクリッ
クします。

ヒント 新しいコントローラのデフォルトの SRSは、60000です。
コントローラとの通信を最初に確立するために、この SRS
を使用する必要があります。通信を確立できたら、SRSを
変更できます。

ヒント Program Managementウィンドウを使用して、コントローラ
の名前を変更できます。プロジェクトツリーと
Configurationを展開します。Resourceを右クリックしてか
ら Renameを選択します。
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6. Hardware Managementプロジェクトツリーが、以下に示すように表示さ
れるまで Resourceを展開します。

7. GuardPLC 1800コントローラの下にある COMを右クリックしてから、
Propertiesを選択します。

8. GuardPLCコントローラの IPアドレスを入力します。Subnet Maskも
Default Gateway も変更する必要はありません。

9. OKをクリックします。

3.4 信号の作成

この章の例では GuardPLC 1800コントローラを使用しているため、プロ
ジェクトツリーのコントローラの下に定義済みの I/Oがリストされていま
す。1200/1600/1800は、構成済みの I/Oがあるパッケージタイプのコント
ローラです。GuardPLC 2000コントローラを使用しているときは、モジュー
ル式のコントローラであるため I/Oを構成する必要があります。

ヒント
T

GuardPLCコントローラのデフォルトの IPアドレスは、
192.168.0.99です。
Pub.No. 1753-PM001A-JA-P



GuardPLCプロジェクトの作成 3-5
3.4.1 Signal Editorの理解

Signal Editorを使用して、アプリケーションのために信号を定義できます。

Name 列には信号の固有の名前が入ります。Nameは必要で、32文字未満の
長さでなければなりません。

Type列には信号の希望するデータタイプが表示されます。デフォルトは
Booleanです。

信号は、通常 RAMメモリに格納されています。ただし、Retain列での
チェックマークは、信号がフラッシュメモリに格納されることを示します。
その結果、電源切断後の再投入、または停止モードからランモードへの切換
えによる再起動に続いてもその値が保持されます。

Constant列では、プログラムコードで変更できない信号の値を指定します。
これは、必ず Init Value列に入力したのと同じ値になります。

Init Value列では信号の初期値を指定します。この値は、Constant がチェック
されていないときに、プログラムコードで変更できます。

重要 信号が Retainとマークされている場合でも、特定のプログラム
コード が上書きされることを防ぐ必要があります。

さらに、Retain機能では以下の 2つのいずれかの方法を使用し
てWarmstartする必要があります。

• Control Panelの ResourceメニューからWarmstartを選択す
る。

• プロジェクトツリーの Resourceの Type Instanceを右クリッ
クしてから、Propertiesを選択する。それから、Autostart 
EnableプルダウンメニューからWarmstartを選択する。
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3.4.2 Signal Editorでの信号の作成

1. Signal Editorを開くには、Hardware Managementメニューバーから Signals 
→ Editorを順に選択します。

2. 3つの新しい信号 (START, STOP, およびMOTOR)を作成します。

a. Signal Editorで New Signalを左クリックします。Nameフィールドに
STARTを入力してから、[Enter]キーを押します。

b. New Signalを再度左クリックします。Nameフィールドに STOを入力
してから、[Enter]キーを押します。

c. New Signalを再度左クリックします。NameフィールドにMOTORを
入力してから、[Enter]キーを押します。
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3.5 信号の I/O端子への接続

信号を Signal Editorから Connect Signalsダイアログの Inputまたは Outputタ
ブにドラッグして、信号を I/Oに接続します。

3.5.1 デジタル入力信号の接続

1. コントローラの入力 (1600の場合は DI 20または 1800の場合はMI 24/8 
FS1000 )または分散 I/Oモジュールを右クリックしてから、Connect 
Signalsを選択します。

2. Signal Connectionsダイアログで Inputsタブを選択しているかを確認しま
す。

入力ごとに 2つの信号 (Valueおよび Error Code)があります。GuardPLC 
1800コントローラでは、Value Analog信号が追加されます。

Error Codeはステータス信号で、ポイントレベルの診断に使用されます。
Valueには、入力が ON (1)または OFF (0)であるか、実際のフィールド状
態が入っています。

ヒント 信号を Signal Editorウィンドウから Signal Connectionsウィ
ンドウにドラッグするだけで簡単に画面をセットアップで
きます。Signal Editorの Nameフィールドと Signal 
Connectionsウィンドウの Signalフィールドの両方を上図に
示すように表示する必要があります。
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3. STARTと STOPを Signal Editorの Nameフィールドから Signal 
Connectionsウィンドウの Signalフィールドにドラッグして、STARTと
STOP信号を入力に接続します。

a. カーソルが Signal Editor や Signal Connectionsダイアログのすべての
フィールドでアクティブでないことを確認します。

b. Nameフィールドを左クリックしたままにして、信号を Signal 
Connections ダイアログの Signalフィールドにドラッグします。

c. 適切なフィールド上で離します。

両方の信号が接続されると、画面は以下のように表示されます。

4. コントローラが GuardPLC 1800の場合は、さらに作業が必要になります。
GuardPLC 1800コントローラのデジタル入力は、実際のアナログ回路で、
分解能が 1ビットです。そのため、DC13Vを超える電圧は 1になり、
DC7V未満の電圧は 0になります。GuardPLCのアナログ回路では使用し
ているチャネルをユーザが指定する必要があるため、GuardPLC 1800コ
ントローラの 24のデジタル入力も必要になります。

a. USEDという新しい信号を Signal Editorに追加します。

b. この信号の初期値は 1です。プログラムのこの値を変更することはで
きないため、USEDは常に 1になります。

c. MI 24/8 FS1000の Outputsタブを選択します。

ヒント 信号は、同じデータタイプの Signalフィールドでのみド
ラッグ &ドロップできます。BOOL信号を BYTEフィール
ドにドロップすることはできません。
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d. USEDを DIチャネルに接続して、DI[17].Usedおよび DI[18].Usedに
なるようにします。

5. DI Signal Connectionsウィンドウを閉じます。

3.5.2 出力信号の接続 

1. コントローラの出力 (DO8)または分散 I/Oモジュールを右クリックして
から、Connect Signalsを選択します。

2. Signal Connectionsウィンドウは、デフォルトでは Inputsタブが表示され
ます。Outputフィールドを表示するには Outputsタブを選択します。

3. 以下に示すようにMOTOR信号を最初の出力に接続します。
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3.5.3 分散 I/O信号の接続

分散 I/Oモジュールの場合は、コントローラに I/Oポイントと同様に、信号
を分散 I/Oモジュールの入力と出力に接続できます。

1. Hardware Managementプロジェクトツリーで分散 I/Oモジュールを展開し
て、入力の場合は DIを、または出力の場合は DOを右クリックします。

2.  Signal Connectionsダイアログにある適切なタブ (Inputsまたは Outputs)を
選択します。

3. 信号を分散 I/Oモジュールの対応する端子にマップするために、信号を
Signal Editorから Inputまたは Output タブにドラッグ &ドロップします。
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3.5.4 アナログ入力信号の接続 (GuardPLC 1800コントロー
ラ )

1. GuardPLC 1800コントローラの入力 (MI 24/8 FS1000)を右クリックしてか
ら、Connect Signalsを選択します。

2. Signal Editorで、アナログ値用に信号を作成します。

3. これらの信号を、Signal Connectionsダイアログの Inputsタブのアナログ
入力に接続します。

4. Signal Connectionsダイアログの Outputsタブを選択します。

5. USED信号を Signal Editor から、アプリケーションで使用しているアナ
ログ入力チャネルに接続します。
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3.5.5 ハイスピードカウンタ信号の接続 (GuardPLC 1800コ
ントローラ )

信号を GuardPLC 1800コントローラのハイスピードカウンタに接続するに
は、ハイスピードカウンタを構成するために最初に信号を作成する必要があ
ります。また、カウンタ値用に信号を作成する必要もあります。それから、
これらの信号をカウンタ入力と出力に接続します。

信号の構成と Counter Value信号の作成

1. Signal Editorで、定数値を持つ True信号と False信号を作成します。
True信号の値は 1で、False信号の値は 0です。

2. カウンタ値用に Count信号を作成します。
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信号の構成と Counter Value信号の接続

1. GuardPLC 1800コントローラのハイスピードカウンタ (HSC2)を右クリッ
クしてから、Connect Signalsを選択して Signal Connectionsダイアログを
開きます。

2. Outputsタブを選択します。

3. True信号と False信号をカウンタ出力に接続して、希望するカウンタの
動作を構成します。

4. Connect Signalsダイアログの Inputタブを選択します。

Counter[xx]出力変数 説明

5/24V Mode True (1) = 24V
False (0) = 5V

Auto Advance Sense True (1) = Direction (方向 )に基づいてカウントアップま
たはダウンする。
False (0) = Direction (方向 )に関係なくカウントアップ
する。

Direction Auto Advance Senseが False (0)のときは、Direction (方
向 )に示されるカウントは以下のようになる。
• True (1) =カウントダウン
• False (0) =カウントアップ

Gray Code True (1) = Gray Code Modeを使用する。
False (0) = Pulse Modeを使用する。

Reset True (1) = カウンタをリセットしない。
False (0) = カウンタをリセットする。

方向に関係なくカウントアップする。

方向に基づいてカウントアップする。
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3-14 GuardPLCプロジェクトの作成
5. 作成した Count信号を Counter Value入力に接続します。

これで、これらの信号をアプリケーション・プログラム・ロジックに使用で
きるようになります。

3.6 ファンクション・ブロック・プログラムの作成

以下の例では、前に作成した 2つの入力信号を使用するモータを始動および
停止するコードを作成しています。

1. Signal Connectionsウィンドウを閉じます。Signal Editorをアクティブなま
まにして、Project Managementウィンドウをリストアします。

2. 必要に応じて、[I] TypeInstanceが表示されるまで Project Managementのプ
ロジェクトツリーを展開して、[I] TypeInstanceをダブルクリックして
Function Block Editorのプログラムページを開きます。

ヒント ファンクションブロックのプログラミングについては、オンラ
インヘルプをご覧になるか、または「第 8章　ユーザ定義の
ファンクションブロックの作成」を参照してください。
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3. 信号を Signal Editor (Hardware Managementの )から、FB Editor program
ページの任意に位置にドラッグします。

ページを最初に編集するときは、ウィンドウではページ名が尋ねられま
すが、ページに名前を指定する必要はありません。OKをクリックして、
ダイアログボックスを閉じます。

4. Hardware Managementウィンドウを最小化します。

5. Project Managementプロジェクトツリーで、以下に示すように
StandardLibs, IEC61131-3, および Bistrを展開します。

ヒント Signal Editorと FB Editorを画面で簡単に一致させるには、
Project Managementと Hardware Managementウィンドウの両
方をリストアします。それから、画面の一番下にある
Windowsタスクバー から Tile Windows Verticallyを選択しま
す。

ヒント 説明に使用する信号の下の白色の領域は、白色の領域をク
リックしてから [Delete]キーを押すことで削除できます。
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3-16 GuardPLCプロジェクトの作成
6. ルーチン上で AND および ORブロックをドラッグします (左クリックし
てから、保持、ドラッグ、および開放する )。

7. ボックスの端の非常に小さな丸をクリックしたままにして、ブロックと
ラインを接続します。宛先の丸にドラッグしてから離します。

8. MOTORを右クリックしてから、Duplicateを選択して重複MOTOR信号
を作成します。ページに信号をドラッグ &ドロップします。

9. 丸を右クリックして Invertを選択することで STOP信号を反転します。

ヒント ツールバーの Zoom In ツールを使用して、ボックスの
端の丸を拡大表示します。

ヒント 標準のファンクションブロックに加えて、「第 8章　ユーザ定
義のファンクションブロックの作成」に説明するように標準の
ファンクション・ブロック・ロジックを含むユーザ定義のファ
ンクションブロックを作成できます。また、TUVに認可され
たアプリケーション固有の安全ファンクションブロックを購入
することもできます。詳細は www.ab.com/guardplcをご覧にな
るか、または当社までお問い合わせください。
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3.7 プログラムの保存、コンパイル、テストおよびダウンロード

3.7.1 プログラムの保存

1. プログラムの編集内容を保存するには Saveボタン を左クリックしま
す。

変更内容をドキュメントするために使用できるウィンドウが表示されま
す。

2. OKをクリックします。

3.7.2 コードのコンパイル

1. Type Instance Programを閉じます。

2. Resourceを右クリックしてから、Code Generationを選択します。

3. コード生成結果が Error State Viewerに表示されます。

Error State Viewerが表示されないときは、赤色の三角形 をクリックす
ると表示できます。

コンパイルが成功すると、Error-State Viewerに ‘Error Free code generated’が表
示されます。

ヒント FBエディタのメニューバーには、最後に保存されてからの編
集の数が表示されます。保存すると、‘(unchanged)’が表示され
ます。

ヒント GuardPLC 1800コントローラを使用しているときは、Error State 
Viewerに警告が表示されます。Hardware Managementウィンド
ウを表示すると、初期値があるがソースがない ‘USED’を読
取ったという警告が表示されます。‘USED’信号の初期値は 1
ですが、その値を駆動するソースがないため、この警告は無視
できます。
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3-18 GuardPLCプロジェクトの作成
3.7.3 オフラインシミュレーションの実行

GuardPLCコントローラにダウンロードする前にコードをテストするには、
オフラインシミュレーションを実行します。

1. Resourceを右クリックしてから、OFF-Line-Simulationを選択します。

OLSタブが表示されます。

2. [I] TypeInstanceをダブルクリックします。

以下の画面が表示されます。
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3. シミュレーション中に、切換え /表示するポイントを選択します。ポイ
ントをアクティブにするには、ポイントを左クリックして、ドラッグし
てから離して、再度左クリックします。

4. 青色のフラグボタンを左クリックしてシミュレーションを開始します。

5. 黄色のフィールドをダブルクリックして、TRUE/FALSEを切換えます。
青色の行は OFFを示し、赤色の行は ONを示します。

6. テストが終了したら、停止アイコンをクリックしてシミュレーションを
停止します。

7. OLSを閉じるアイコンを使用して、オフラインシミュレーションを閉じ
ます。

8. PROJタブをクリックして、プロジェクトツリーに戻ります。

ヒント 変更内容を保存しないときは、シミュレーションするポイ
ントを再度選択する必要があります。
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3.7.4 プログラムのダウンロード

1. カテゴリ 5の Ethernet ケーブルを使用して、GuardPLCコントローラと
PCの Ethernetポートを接続します。

2. Hardware Managementウィンドウで、Signal Editorを閉じます。

3. [60000] Resourceを右クリックします。

4. Online→ Control Panelを順に選択します。

5. パスワードなしでデフォルトのユーザ名 (Administrator)を入力してから、
OKをクリックします。

Control Panelが開きます。

オンラインにできないときは、GuardPLCコントローラの IPアドレスと
SRSの決定方法と、PCの IPアドレスの適切な設定方法については、「第
2章　GuardPLC分散 I/Oモジュールへの接続」を参照してください。

6. GuardPLCコントローラがランモードのときは、停止モードに変えます。
Control Panelの停止アイコンを左クリックします。

7. 警告のプロンプトに対して Yesと答えます。

8. ダウンロードアイコンを左クリックします。

ヒント [Ctrl]+[A]ショートカットを使用して、デフォルトのユーザ
名とパスワードを入力できます。
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9. 警告のプロンプトに対して Yesと答えます。

10.Statusフィールドに ‘Resource Configuration successfully loaded’メッセージ
があることをチェックして、ダウンロードが正常に完了したことを確認
します。

11. Coldstartボタンをクリックして警告プロンプトに Yesと答えて、
GuardPLCコントローラをランモードにします。

3.8 ルーチンのオンラインでのモニタ方法

ルーチンをオンラインでモニタするには、コントローラとオンラインになっ
た状態で、コントローラがランモードでなければなりません。

1. Project Managementウィンドウで、Resourceを右クリックしてから
ON-Line Testを選択します。

Project Managerが以下のように表示されます。
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2. [I] TypeInstanceをダブルクリックします。

ラインが赤色 (TRUE)および青色 (FALSE)のときは、モニタがアクティ
ブです。ルーチンをテストして、ファンクションコードをモニタします。

3. テストが終了したら、オンラインテストを閉じます。

4. PROJタブをクリックして、プロジェクトツリーに戻ります。

ラインが赤色 /黒色の縞模様になっているときは、Control Panelが
GuardPLCコントローラとオンラインになっていないか、またはコント
ローラがランモードではありません。

GuardPLCコントローラとオンラインにすることについては、「第 2章　
GuardPLC分散 I/Oモジュールへの接続」を参照してください。

ヒント ダウンロードについては、「第 4章　ルーチンのチェック、ダ
ウンロード、始動、およびテスト」を参照してください。
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第 4章

ルーチンのチェック、ダウンロード、始
動、およびテスト

4.1 本章の内容

ルーチンをダウンロードして実行するには、以下を行なっていなければなり
ません。

• システム構成とルーチンロジックを完了する。

• Project Managementメニューバーで Object→ Saveを順に選択してロジッ
クを保存する。

• コードを生成する。コードを生成する前にすべてのシステム構成が完了
していることを確認する。

• プログラミングターミナル (RSLogix Guard PLUS!ソフウェアが稼動して
いる )にコントローラを接続する。

• ルーチンをコントローラにダウンロードする (4-2ページを参照 )。

• ルーチンを始動する ( 4-4ページを参照 )。

4.2 一貫性のチェック

ルーチンをダウンロードする必要があるかを判断するには、Check 
Consistency (一貫性のチェック )機能を使用してコントローラで稼動してい
るルーチンが RSLogix Guard PLUS!ソフトウェアで編集しているルーチンと
同じであるかを確認できます。Resource→ Check Consistencyを選択して、2
つのプログラムを比較します。コードがすべて一致しているときは、オフラ
インルーチンはコントローラにすでにダウンロードされています。

内容 参照ページ

一貫性のチェック ( ルーチンをダウンロードする必要があるか ) 4-1

ルーチンのダウンロード 4-2

ルーチンの始動 4-4

ルーチンのテスト 4-5

ルーチンの実行方法 4-6
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4.3 ルーチンのダウンロード

1. Online→ Control Panelを順に選択します。

ソフトウェアが自動的にログインするかを尋ねます。

2. 正常にログインできると、Control Panelが開きます。

3. ダウンロードを行なう前にルーチンを停止する必要があります。
Resource→ Stopを順に選択します。

4. Resourc→ Downloadを順に選択して、ルーチンをコントローラにロード
します。

DownloadColdstart

停止

重要 コントローラが FAILURE_STOPのときは、ルーチンをダウン
ロードする前にリブートする必要があります。コントローラと
オンラインのときに、Control Panelから Reboot Resourceを選択
します。

FAILURE_STOPからの回復については、『GuardPLCコント
ローラシステム　ユーザーズマニュアル』(Pub.No. 
1753-UM001)を参照してください。
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4.3.1 ダウンロードプロセスのトラブルシューティング

ルーチンをダウンロードするためには、コントローラの SRSはルーチンに
保存されている SRSと一致していることが必要です。プロジェクト内でコ
ントローラの SRSを指定するときは、コードを生成するときにルーチンに
保存された SRSが取得されます。

コントローラの SRのチェック

1. Online→ Communication Settingsを順に選択します。

2. MAC addressフィールドに、コントローラのMACアドレスを入力しま
す。

MACアドレスは、GuardPLC 1200コントローラの側面のステッカーと、
GuardPLC 1600/1800コントローラと I/Oの下方の RJ-45コネクタ上にあ
るラベル、または GuardPLC 2000コントローラの AB-CPUモジュールの
フロントベゼルに記載されています。

3. Getをクリックします。

コントローラは現在使用している IPアドレスと SRSを返します。

これで、正しい SRSを使用していることを確認できました。SRSを変更し
て、コードを再度生成すると、ダウンロードを行なうことができます。

コントローラの SRSの更新

場合によっては、ほとんどの場合は FAILURE_STOPによるリブート後に、
コントローラの SRSがルーチンの SRSと同じであっても、ルーチンがダウ
ンロードできなくなることがあります。これが起こったときは、以降のペー
ジに示すように SRSを同じ番号に変更してから OKをクリックします。こ
れによって、コントローラの SRSが更新され、問題が解消できます。これ
で、ルーチンをダウンロードできるようになります。

ヒント FAILURE_STOPからの回復については、『GuardPLCコント
ローラシステム　ユーザーズマニュアル』(Pub.No. 
1753-UM001)を参照してください。
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1. Extra→ Change System ID (SRS)を順に選択します。

2. SRSを入力してから、OKをクリックします。

3. 再度ダウンロードを行ないます。

4.4 ルーチンの始動

ルーチンをダウンロードできたら、ルーチンを始動できます。Control Panel
から、Resource→ Coldstartを順に選択するか、またはメニューバーの
Coldstartボタンを使用します。

オプション 説明

Warmstart ユーザがプログラミングターミナルからルーチンを開始でき、前
に保存された Retain信号で継続できる。
Warmstartを起動するには、Administratorまたは Read/Writeアクセ
スであることが必要です。

Coldstart ルーチンが STOPまたはフリーズモードのときに、この cold start
オプションを使用して開始できる。Coldstartオプションではルー
チンを再度初期化し、有効なプロセス値が失われる。

Stop このオプションを使用して、ランモードまたはフリーズモードの
ルーチンを停止する。

または
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4.5 ルーチンのテスト

ルーチンをチェックしてエラーをなくすためにテストします。ルーチンをテ
ストするときは、Administratorまたは Read/Writeアクセスでなければなりま
せん。テストオプションを以下の表に説明します。

Control Panelの Test Modeメニューから、使用するテストオプションを選択
します。

テストオプション 説明

Enter Test Mode (Hot Start) Test Mode Hotにするには、ルーチンがコントローラにロードされて始動していなけ
ればならない。

セキュリティクエリの後、ルーチンが一次停止する (FREEZE)が、サイクルの終了
後も現在のプロセスデータが保持される。入力信号は処理されない。出力信号は現
在の状態を保持する。

Enter Test Mode (Warm Start) ルーチンの実行が中断され、Retainと宣言された信号はそれらの値を保持し、他の
すべての信号はリセットされる。

Enter Test Mode (Cold Start) Test Mode Coldにするには、ルーチンがコントローラにロードされていなければな
らない。

セキュリティクエリの後、ルーチンが初期化され、始動して、すぐにフリーズモー
ドになる。入力信号が処理されず、すべての出力信号は基本的な状態のままにな
る。

ルーチンがランモードのときに、Test Mode Coldを選択すると、処理中のサイクル 
が終了してプロセスデータが再度初期化される。

Single cycle シングルサイクルは、コントローラがテストモードのときのみ実行できる。シング
ルサイクルを使用して、ルーチンのシングルサイクルを手動で実行をトリガする。
ルーチンは正確に 1回実行される。入力信号が読取られ、処理され、その結果の出
力信号が転送される。

Forceエディタを使用して、データを段階ごとにチェックできる。強制については、
第 5章を参照してください。

Continue with Run このオプションはテストモードを終了する。ルーチンのモードが再初期化すること
なく FREEZEからランに変更される。現在のプロセスデータは保持される。(これ
は、ルーチンの hot startに対応する。)
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4.6 ルーチンの実行方法

コントローラには 1つのルーチンのみがあります。ルーチンは以下の状態の
いずれかになります。

4.6.1 ルーチンの制御

以下に説明する動作を使用してルーチンを制御できます。

ルーチンの状態 説明

RUN_RUN コントローラはランモードです。
• ルーチンはコントローラで周期的に実行される。
• 入力データがルーチンで処理される。
• ルーチンの出力データが動作する。

RUN_FREEZE コントローラはランモードです。
• ルーチンは実行されない。 
• 入力データはルーチンで処理されない。
• ルーチンの出力データは動作しない。
重要：このモードは安全関連動作には使用できない。

STOP コントローラは停止モードです。
• ルーチンは (もう )実行されない。
• すべての出力はリセットされる。

FAILURE_STOP コントローラは停止モードです。
• ルーチンはエラーによって停止する。
• すべての出力がリセットされる。

制御動作 説明

Start the routine from STOP
(停止モードからルーチンを始動 )

ルーチンを始動することは、コントローラを停止モードからランモードに転送する
ことと同じです。その後、ルーチンを RUN_RUNモードに転送する。始動中にフ
リーズをアクティブにすると、ルーチンは RUN_FREEZEモードになる。ただし、
Freeze Enableソフトウェアスイッチが有効になっているときのみ、フリーズ動作が
可能です。フリーズモードでの始動に加えて、コールド始動も可能です。

ルーチンを始動することは、コントローラの再起動スイッチおよびルーチン再起動
スイッチが有効になっているときにのみ可能です。

Start the routine from RUN
(ランモードからルーチンを始動 )

このモードでまだルーチンが動作していないときは、ルーチンを RUN_RUNモード
に転送する。また、コールド始動、ホット始動、および非フリーズモードでの始動
も可能です。

重要：この機能はコントローラの安全動作には使用できない。
Single cycle the routine
(ルーチンのシングルサイクル )

ルーチンは RUN_FREEZEモードでなければならない。ルーチンを正確に 1回のサ
イクルのみ実行し、その後、ルーチンが RUN_FREEZEモードに戻る。シングルサ
イクルのコマンドは、属性がホット始動とフリーズである始動コマンドです。これ
は、コントローラのモードに何も影響しない。フリーズモードが有効なときは、シ
ングルサイクルはルーチンのためにコントローラによってのみ実行される。

重要：この機能はコントローラの安全動作には使用できない。
Restart the routine
(ルーチンを再起動 )

ルーチンが FAILURE_STOPモードのときは、プログラミングソフトウェアから始
動コマンドを使用して再起動できる。再起動後、ルーチン全体が再度チェックされ
る。

Stop the routine
(ルーチンを停止 )

ルーチンを停止することは、コントローラをランモードから停止モードに転送する
ことと同じです。その後、ルーチンはランから停止モードに転送される。

Freeze the routine
(ルーチンをフリーズ )

ルーチンを RUN_RUNモードから RUN_FREEZEモードに転送する。これはコント
ローラのモードに影響しない。フリーズモードをルーチンのために有効にしてなけ
ればならない。

重要：この機能はコントローラの安全動作には使用できない。
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信号のモニタおよび強制

5.1 本章の内容

5.2 信号のモニタ

Force Editorは、強制されているかをモニタする信号を選択するウィンドウ
を提供します。

1. Resourceを右クリックしてから、Online→ Force Editorを順に選択しま
す。

Control Panelがすでに開いているときはログインする必要はありません。
そうでなければ、ソフトウェアがログインを求めます。

内容 参照ページ

信号のモニタ 5-1

強制 5-3

強制の有効 5-3

Force Editorの起動 5-4

強制値の指定および強制のマーク 5-4

強制時間 5-5

強制の開始 5-6

強制の停止 5-7
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2. 正常にログインできると、ソフトウェアが Force Editorを表示します。

3. Force Editorで、Configureを選択します。

ソフトウェアは、表示するかしないかを選択するための強制信号のリス
トを表示します。

4. まだ接続されていないときは、Force Editorで File→ Connectを順に選択
します。

ソフトウェアは、選択した信号の値を表示します。

R-Value (Resource Value)
列は、信号の現在値を表示
する 。
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Force Editorで構成されたいずれの信号も強制できます。

5.3 強制

強制は、コントローラにロードされたアプリケーションプログラムのロジッ
クへのユーザの介入を説明します。データが強制されると、コントローラ
は、そのプロセス値ではなく強制された値を使用します。これによって、コ
ントローラの安全に影響する 1つまたは複数の信号値が変更されます。

コントローラに使用されている信号のみを強制できます。アプリケーション
プログラムおよび入力 と出力は、コントローラがランモードのときのみ影
響されます。

5.4 強制の有効

強制を有効にするには、Forcing allowed switchと Main Enable switchの両方を
設定する必要があります。Forcing allowed switchはプログラミングソフト
ウェアで設定できますが、設定できるのはコントローラが RUNまたは停止
モードのときのみです。

強制値は以下のいずれかが起こるまでコントローラに保持されます。

• ユーザプログラムが停止する。

• 強制値が他の値に置き換わる。

• コントローラがオフに切り換わる。

注意 安全タスクのあるコントローラで強制を使用するときは、必ず
『GuardPLC Controller Systems Safety Reference Manual』
(Pub.No. 1753-RM002)にリストされる制限に従ってください。

ヒント 新しい構成をロードすると、すべての強制スイッチが切換えら
れ、関連する強制値がリセットされます。
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5.5 Force Editorの起動

ユーザは、アクセス特権に関係なく Force Editorを起動できます。ただし、
Forcing allowed がコントローラで有効になっているときのみ信号を強制でき
ます。強制は、Readアクセスのユーザに対しては常に無効になります。

Force Editorを起動する前に、コントローラで稼動しているプログラムと、
RSLogix Guard PLUS!ソフトウェアで編集しているプログラムが同じである
ことを確認します。

以下の手順に従って、これらのプログラムが同じであることを確認してくだ
さい。

1. Control Panelを起動して、Resource→ Check Consistencyを順に選択しま
す。

2. オフライン /オンラインプログラムが同じでないときは、Force Editorは
オフラインになります。

5.6 強制値の指定および強制のマーク

以下の手順に従って、信号に強制値を設定してください。

1. Force列の信号に強制値を入力します。

2. F列をダブルクリックして、コントローラがプロセス値ではなく強制値
を使用することを示すマークをつけます。

3. 強制値をコントローラに送信します。

Force Editorは、R-Force列の強制値を表示します。RF (resource force)列
のマークは、強制が有効なときはコントローラがプロセス値のかわりに
対応する強制値を使用することを示します。

ヒント Boolean信号の場合は、Trueまたは Falseと 1または 0が使
用できる値です。
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複数の強制値を、同時にコントローラに書込むことができます。強制値は
ルーチンを再ロードするまでコントローラに保存されたままになります。
ルーチンが停止すると、Resource force marks もリセットされます。

5.7 強制時間

強制時間はコントローラにモニタされます。強制時間を sec単位で入力する
には、Forcing allowedが設定された状態でコントローラはランモードまたは
停止モードでなければなりません。強制を無制限にアクティブにする場合
は、‘-1’を入力します。

強制プロセスを開始すると、強制時間が開始します。新しい構成がロードさ
れるか、または動作電圧が切り離されると、時間が 0にリセットされます。

指定の時間後、強制のアクティブが終わります。コントローラが Stop on 
Force Timeoutを有効に切換えると、強制が終わったときにルーチンは停止
モードに戻ります。Stop on Force Timeoutが無効なときは、強制が終わると
ルーチンは現在のプロセス値で継続します。

フィールド 説明

Signal 強制したい信号の名前
Force 信号に強制したい値

入力した値は、Typeフィールドに表示されるタイプと一致しなければならない。

F (force mark) このフィールドのチェックは、強制がアクティブなときに入力した強制値がコント
ローラに送信され、保存され、アクティブになることを示す。

この列をダブルクリックして、コントローラがコントローラのプロセス値ではなく
この強制値を使用することを示すためにマークをつける。

Type 信号エディタに定義された信号のタイプを表示する。
R-Value (resource value) 現在のプロセスとプログラムロジックからのコントローラ値を表示する。
R-Force (resource force value) 強制がアクティブなときの信号の値を表示する。
RF (resource force mark) このフィールドのチェックは、強制がアクティブになるとすぐに、コントローラが

プロセス値ではなく強制値を使用することを示す。
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5.8 強制の開始

以下の手順に従って、強制を開始してください。

1. Start… タブをクリックするか、または File→ Startを順に選択します。

2. Force Timeを Start forcingダイアログボックスに入力して、Startをクリッ
クします。

3. Force Editorが開きます。

強制が開始すると、Forcing activatedボックスがチェックされ、R-Force値が
R-Valuesに優先します。
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5.9 強制の停止

強制を停止するには、Stop… タブをクリックするかまたは File→ Stopを順
に選択します。

強制が停止すると、Forcing activatedチェックボックスがクリアされます。
ただし、Resource Force Mark (RF)フィールドはまだチェックされたままで、
強制値がリソースにあるが、アクティブではないことを示します。
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Notes:
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第 6章

アクセス管理

6.1 本章の内容

6.2 コントローラによるアクセスレベルの使用方法

Administratorは、コントローラ 1台当たり最大 10のユーザにアクセス特権
を設定できます。コントローラはアクセス特権をその不揮発性メモリに記憶
します。アクセス特権はプログラムには保存されず、プログラムでコント
ローラにダウンロードされません。コントローラを変更すると、アクセス特
権を再度入力する必要があります。

各コントローラには、以下の状態のときに適応する同じデフォルトのユーザ
アカウントがあります。

• コントローラが新しく、最初の設定のまま

• バックアップバッテリを外して、動作電圧を切り離したとき (GuardPLC 
1200/2000コントローラのみ )

• リセットボタンを使用したとき (GuardPLC 1600/1800コントローラのみ )
リセットボタンの使用方法については、『GuardPLCコントローラシステ
ム　ユーザーズマニュアル』(Pub.No. 1753-UM001)を参照してください。

デフォルトのアカウントは、以下の通りです。

Username: Administrator

Password: <blank>

Access Type: Administrator

内容 参照ページ

コントローラによるアクセスレベルの使用方法 6-1

ユーザアクセスの作成 6-2
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以下のアクセスレベルを使用できます。

6.3 ユーザアクセスの作成

以下の手順に従って、ユーザ・アクセス・レベルを作成してください。

1. Online→ Access Managementを順に選択します。

Control Panelが開いているときは、ログインする必要はありません。そ
うでないときは、ソフトウェアがログインを求めます。

2. Administratorアクセスで正常にログインできたら、ソフトウェアが
Access Managementウィンドウを表示します。

アクセスレベル 可能な操作

Administrator • 最高の特権
• ユーザ名とパスワードを管理する。
• コントローラからデータを読取る。
• ルーチンとデータをコントローラに書込む。
• タグを強制する。
• ルーチンを停止、始動、フリーズ、および強制する。
• オペレーティングシステムをダウンロードする。
• コントローラをリブートする。
• IPアドレスとシステム IDを変更する。
• Read/Writeおよび Readレベルでもログインできる。

Read/Write • コントローラからデータを読取る。
• ルーチンとデータをコントローラに書込む。
• タグを強制する。
• ルーチンを停止、始動、フリーズ、および強制する。
• Readレベルでもログインできる。

Read • 最低の特権
• コントローラからデータを読取ることのみができる。
Pub.No. 1753-PM001A-JA-P



アクセス管理 6-3
ユーザ名とパスワードは、大文字と小文字を区別し、最大 31文字にできま
す。文字、数字、アンダースコア ( _ )文字を使用できます。

少なくとも 1人のユーザに Administrator特権を割当てる必要があります。

ユーザリストに対して変更を行なったときは、Set Accountsボタンを使用し
て変更内容をコントローラに保存します。

Administratorは、デフォルトのアカウントアクセスのすべてのユーザのアク
セス特権を削除でき、Administratorアカウントを Administratorのデフォルト
設定でパスワードなし (空白）にリセットできます。

フィールド 説明

Username ユーザの名前
Password ユーザのパスワード

パスワードは大文字と小文字を区別する。
Password Verification パスワードが上記のように指定されているか確認する。
Access Type ユーザのアクセスレベル 

Administrator, Read/Write, Read, または No Accessを指定する。

重要 アクセス特権への変更は、コントローラが STOPの状態のとき
のみ行なうことができます。

ヒント GuardPLC 1200または GuardPLC 2000コントローラへのバッテ
リと外部電源を同時にオフにすると、コントローラはすべての
アカウント情報を失い、デフォルトのアカウントに戻ります。
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第 7章

プロジェクトのアーカイブおよびリストア

7.1 本章の内容

プロジェクトをアーカイブすると、プロジェクトをバックアップ場所に移動
します。また、プロジェクトがフリーズ (凍結 )されるため、変更できなく
なります。アーカイブされたプロジェクトは 1つの PCから他の PCに移動
したり電子メールで送信することができます。インストール中に問題が起
こってもプロジェクトが失われることがないように、新しいバージョンの
RSLogix Guard PLUS!ソフトウェアをインストールする前に、すべてのプロ
ジェクトをアーカイブする必要があります。

プロジェクトが複数のリソースでの 1つだけであっても、アーカイブできま
す。アーカイブプロセスは、archivename.L3Pのタイトルが付けられたフォ
ルダを作成します。この場合 archivenameはアーカイブの名前です。フォル
ダには 3つのアーカイブファイルが入ります。アーカイブされたプロジェク
トをリストアすると、projectname.L2Pフォルダが作成されます。

内容 参照ページ

プロジェクトのアーカイブ 7-2

プロジェクトのリストア 7-3
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7.2 プロジェクトのアーカイブ

以下の手順に従って、プロジェクトをアーカイブしてください。

1. RSLogix Guard PLUS! Program Managementウィンドウを開きます。

2. プロジェクトツリーでプロジェクト名を右クリックして から、Archive
を選択します。

3. Browseボタンをクリックしてから、アーカイブされたプロジェクトを入
れたいフォルダを選択します。

4. アーカイブされたプロジェクトの名前を Object Nameフィールドに入力
します。

アーカイブに使用する名前は、プロジェクトの現在の名前と同じにする
必要がありません。

5. OKをクリックします。

6. ターゲットのディレクトリと名前が適切であることを確認して、Archive
をクリックします。

アーカイブプロセスが完了すると、Project Managementページが再度表示さ
れます。
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7.3 プロジェクトのリストア

アーカイブされたプロジェクトをリストアするとは、アーカイブファイルか
らプロジェクトファイルを抽出して、編集できるように .L2Pファイルと
フォルダを作成することです。

以下の手順に従って、アーカイブされたプロジェクトをリストアしてくださ
い。

1. Project Managementウィンドウを開きますが、プロジェクトは開きませ
ん。

2. Projectプルダウンメニューから Restore Project…を選択します。

Restoreダイアログが開きます。

3. リストアされるプロジェクトを入れる場所であるターゲットのディレク
トリをブラウズします。

4. リストアしたいアーカイブされたプロジェクトをブラウズします。

5. Restoreをクリックします。

プロジェクトがターゲットのディレクトリにリストアされ、開きます。
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第 8章

ユーザ定義のファンクションブロックの
作成

8.1 本章の内容

8.2 ユーザ定義のファンクションブロックの作成

RSLogix Guard PLUS!ソフトウェアを使用して、以下の図に示すように標準
のファンクションブロックのロジックを含むユーザ定義のファンクションブ
ロックを作成できます。

既存のファンクションブロック

内容 参照ページ

ユーザ定義のファンクションブロックの作成 8-1

変数の宣言 8-4

宣言された変数のユーザ定義のファンクションブロッ
クのページへの移動

8-8

ファンクション・ブロック・コードの生成 8-9

ユーザ定義のファンクション
ブロック
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以下の手順に従って、ファンクションブロックを作成してください。

1. Program Managementウィンドウで、Configurationを右クリックしてから
New→ Libraryを順に選択します。

2. 新しい Libraryを右クリックしてから、New→ Function Block Typeを順に
選択して新しいファンクションブロックを作成します。

3. ファンクションブロックを右クリックしてから Renameを選択すること
で、新しいファンクションブロックの名前を指定できます。
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ユーザ定義のファンクションブロックの作成 8-3
4. 新しいファンクションブロックをダブルクリックして、エディタを起動
します。

ユーザ定義のファンクションブロックの FBDエディタは、ルーチンの FBD
エディタとはわずかに異なります。エディタのコンポーネントは以下の通り
です。

概要ウィ
ンドウ

インターフェイス
宣言エディタ

描画領域

変数宣言エディタ

コンポーネント 操作内容

概要ウィンドウ ファンクションブロックのダイアグラムを縮小スケールで表示する。

描画領域 FBタイプのロジックを作成する。

変数宣言エディタ
(FBタイプエディタのみ )

ブロックの内部変数を作成して定義して、将来の使用のために初期化する。

インターフェイス宣言エディ
タ (FBタイプエディタのみ )

ブロックのグラフィカルな外観を定義する。
ブロックの外観は、FBDエディタでのユーザ定義のファンクションブロックの外観
と一致する。

重要 ユーザ定義のファンクションブロックのインスタンスをそれ自
身の内部には配置できません。
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8.3 変数の宣言

変数宣言は、ファンクションブロックの接続ポイントを定義します。以下の
タイプの変数用のタブがあります。

変数に使用できるデータタイプには、BOOL, BYTE, DINT, DWORD, INT, 
LREAL, REAL, SINT, TIME, UDINT, UINT, USINT, WORDがあります。デ
フォルトのタイプは BOOLです。

コントローラは、REAL値を浮動小数点の値 として、LREAL値を倍精度整
数値として処理します。

変数を宣言するには、ユーザ定義の FBDエディタから変数タイプのタブを
選択します。空白領域のどこかで右クリックしてから、New Variableを選択
します。

ここまたは Derivation Typeボタン (推奨 )のいずれかを使用して、変数を定
義できます。Derivation Typeボタンはダイアログをアクティブにして、選択
したタイプの変数を宣言できます。以下のボタンを使用して、文法が正確で
あることを確認します。

タブ 定義内容

VAR タイプ制限なしの内部変数
属性も定義できる。
CONST ロジックで変更できない定数値

VAR_INPUT ブロックにも表示される入力変数
VAR_OUTPUT ブロックにも表示される出力変数
VAR_EXTERNAL ファンクションブロックまたはファンクション内でも使用お

よび編集できるグローバル変数。変更した値は、外部でも表
示できる。

ACTION アクションブロック
アクションブロックには、実行される動作と、トリガする動
作を説明する。
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ユーザ定義のファンクションブロックの作成 8-5
使用するボタン 変数タイプの定義

Direct 他の変数タイプから直接派生する。

Array 1つまたは複数の次元の配列

例えば、
INTの ARRAY配列 [1..10]
• INT値の 1次元配列 
• ARRAY[7]は、7番目のエレメントにアクセスする。
REALの ARRAY配列 [1..10,1..10]
• REAL値の 2次元配列
• ARRAY[3,5]は、5番目の行の 3番目のエレメントにアクセスする。

Subrange 特定の範囲内であるべき値

例えば、
DINT(0,200)は、以下のような DINT値になる。
• 許容可能な最小値は 0で、
• 許容可能な最大値は 200です。

Enumeration まだ実装されていない。
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8.3.1 技術単位とスケーリングの定義

変数ごとに技術単位とスケーリングを定義できます。

以下に、使用可能な技術単位を示します。

フィールド 定義

Techn. unit プルダウンメニューから有効な単位
min. value
max. value

技術単位を内部値に変換する参照ポイント
例えば、
• 技術単位 0～ 24V
• 内部表現 0～ 1000
スケーリングのために浮動小数点の値を入力する。

internally represented as

略語 単位 定義

A アンペア 電流

Bq ベクレル 放射能の強さの単位、原子核が崩壊して放射線を放つ
放射能の量

C クーロン 電荷

cd カンデラ 光度

F ファラッド 静電容量

Gy グレイ 吸収線量

H ヘンリー インダクタンス

Hz ヘルツ 周波数

J ジュール エネルギー

K ケルビン 絶対温度 (ケルビン単位 )

kg キログラム 質量

lm ルーメン 輝度

lx ルクス 照度

m メートル 長さ

mol モル 物質量

N ニュートン 力

Ohm Ω(オーム ) 電気抵抗

Pa パルカル 圧力

Rad ラジアン 平面角

s ジーメンス コンダクタンス

S 秒 (Sec) 時間

sr sRadiant 立体角

T テスラ 磁束密度

V ボルト 電位

W ワット 電力

Wb ウェーバー 磁束
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ユーザ定義のファンクションブロックの作成 8-7
8.3.2 I/O位置の定義

入力変数と出力変数の場合は、ファンクションブロックの変数の位置を定義
する必要があります。変数宣言表示の Position部分は、入力と出力変数での
み使用できます。以下を定義できます。

8.3.3 変数の表示方法

変数を宣言すると、エディタは変数を表示します。

エディタは、以下のシンボルを使用して変数を識別します。

フィールド 定義内容

Connection 入力または出力を接続する必要があるブロックのサイド (左、右、上または下 )

Position ブロック内の入力または出力の位置
Inverted データタイプ BOOLの I/Oを反転しているかどうか

BOOLデータのみを反転できる。反転されているときは、I/Oの周りに円が表示さ
れる。

Alternate I/O identifier I/O名
生成された名前ではなく、この名前がブロックに表示される。

シンボル 定義内容

ソースとして使用する。
変数は読取られる。

シンクとして使用する。
変数は書込まれる。

ソースとシンクとして使用する。
変数は読み書きできる。
異なるタイプのコネクションに使用される変数も、このシンボルで識別される。

ソースまたはシンクとして使用されないが、変数はファンクション・ブロック・ダ
イアグラムに設定されている。

未使用
変数が宣言されたが、ファンクション・ブロック・ダイアグラムに設定されていな
い。
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8-8 ユーザ定義のファンクションブロックの作成
8.4 宣言された変数のユーザ定義のファンクションブロックのページへの
移動

これらの宣言された変数を使用するためには、以下を行なう必要がありま
す。

1. Variable Definition Editorからユーザ定義のファンクションブロックの
ページにドラッグします。

2. 必要なファンクションブロックにドラッグダウンして、必要なコネク
ションをすべて行なってください。

完了した ユーザ定義のファンクションブロックを使用するには、ファンク
ションブロックのぺージにドラッグしてから、信号をそれらに接続する必要
があります。
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ユーザ定義のファンクションブロックの作成 8-9
8.5 ファンクション・ブロック・コードの生成

ファンクションブロックのロジックを完了したら、ロジックをコントローラ
が実行できるコードにコンパイルする必要があります。Program Management
ウィンドウで、プロジェクトを展開します。Resourceを右クリックしてか
ら、Code Generationを選択します。

ソフトウェアがファンクションブロックのロジックをコンパイルして、コン
トローラにダウンロードするファイルを生成します。

重要 Code Generate (コード生成 )を行なう前に保存しなければなり
ません。ファンクションブロックのページの変更には保存が必
要です。

変更を行なうと、ファンクションブロックのメニューバーに表
示される変更の数が増加します。

保存が完了すると、メニューバーに unchangedが表示されま
す。

重要 コードジェネレータがロジックをコンパイルするときは、
Hardware Managementウィンドウに指定された設定も考慮しま
す。これらの設定を変更して 変更内容を有効にしたいときは、
プロジェクトを再度コンパイルしてからダウンロードする必要
があります。
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8.5.1 エラーおよび警告のチェック

コードが生成できたら、Project Managementウィンドウの一番下にあるス
テータスバーをチェックします。ステータスバーには、.L2Pファイルが生
成できたかできなかったかが示されます。

.L2Pファイルが作成されなかったときは、コード生成中のコンパイルのエ
ラーまたは警告を表示する Hardware Managementウィンドウをチェックしま
す。

以下のウィンドウに、コード生成の警告の例を示します。
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付録 A

プログラミングソフトウェアのバージョ
ン、互換性、およびファームウェアアッ
プデート

A.1 本付録の内容

A.2 RSLogixおよび RSLogix Guard PLUS!バージョン

内容 参照ページ

RSLogixおよび RSLogix Guard PLUS!バージョン A-1

RSLogix Guard PLUS!ソフトウェアと GuardPLCファームウェアの
互換性

A-3

プロジェクトの変換 A-5

GuardPLCファームウェアのアップグレード A-5

プログラミング
ソフトウェア Cat. No. Ver. サポートされるコントローラ 制限

アクティベー
ション

RSLogix Guard 1755-PCS 3.3 GuardPLC 1200シリーズ B(3)

GuardPLC 2000シリーズ B
• 650のタグ
• ルーチン当たり 40の
ユーザ定義ファンク
ションブロック

• 100ページ

ソフトウェアア
クティベーショ
ンが必要

1754-PCS 3.3 GuardPLC 1200シリーズ B • 200のタグ
• ルーチン当たり 15の
ユーザ定義ファンク
ションブロック

• 100ページ
RSLogix Guard 
PLUS!

1753-PCS-USB(1) 3.5 GuardPLC 1200シリーズ C
GuardPLC 2000シリーズ C
GuardPLC 1600
GuardPLC 1800

タグ、ユーザ定義ファンク
ションブロック、または
ページ制限なし

ハードウェアア
クティベーショ
ンが必要1753-PCS-PAR(2) 3.5

RSLogix Guard 
PLUS!

1753-PCS-USB(1) 4.0/4.1 GuardPLC 1200シリーズ C
GuardPLC 2000シリーズ C
GuardPLC 1600
GuardPLC 1800

タグ、ユーザ定義ファンク
ションブロック、または
ページ制限なし

ハードウェアア
クティベーショ
ンが必要1753-PCS-PAR(2) 4.0/4.1

(1) USBハードロック
(2) 並列ポートハードロック
(3) シリーズ Cコントローラに RSLogix Guardソフトウェアを使用することについては、A-2ページの「RSLogix Guardソフトウェアの
バージョン 3.3」を参照してください。
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A.2.1 RSLogix Guardソフトウェアのバージョン 3.3

コントローラを始動、停止、またはリブートするために、RSLogix Guardソ
フトウェアを GuardPLCコントローラに対してオンラインにできます。ただ
し、プロジェクトツリーでサポートされていないコントローラ (例えば、
GuardPLC 1600)が含まれるプロジェクトを開くことはできません。RSLogix 
Guardソフトウェアは、プログラムを GuardPLC 1600または 1800にダウン
ロードできません。

RSLogix Guardソフトウェアはオンラインにして、シリーズ Cの GuardPLC 
1200および GuardPLC 2000コントローラのプログラムをダウンロードおよ
びモニタすることができます。ただし、すべての機能がサポートされている
わけではありません。RSLogix Guardは、GuardPLC Ethernet上の GuardPLC
分散 I/Oを構成することはできません。シリーズ Cコントローラとオンライ
ンにするときは、メモリマップがシリーズ Bとシリーズ Cコントローラで
異なるために、サブネットマスクなどいくつかの項目の表示が不正確になり
ます。

A.2.2 RSLogix Guard PLUS!

RSLogix Guard PLUS! Ver. 3.5には、GuardPLC 1600および GuardPLC 1800コ
ントローラ、および GuardPLC分散 I/Oのサポートの他に、オフラインシ
ミュレーションおよびオンラインテスト機能などが追加されています。

RSLogix Guard PLUS!は、動作可能なシリーズ B GuardPLC 1200または
GuardPLC 2000コントローラをモニタ、始動、および停止するために使用で
きます。

RSLogix Guard PLUS! Ver. 4.0には、GuardPLC 1600および GuardPLC 1800コ
ントローラに DeviceNet Safetyのサポートが追加されています。Ver 4.0は、
GuardPLC Controllers (1753-DNSI), および 1791DS DeviceNet Safety I/Oのため
に DeviceNet Safetyスキャナをサポートしています。GuardPLC 1200および
GuardPLC 2000は、DeviceNet Safetyをサポートしていません。

ヒント RSLogix Guard PLUS!を使用してシリーズ Bコントローラをダ
ウンロードする必要があるときは、コントローラをシリーズ C
に更新してください。これによって、シリーズ B GuardPLCコ
ントローラがサポートしていない機能に関するダウンロードの
問題を防ぐことができます
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プログラミングソフトウェアのバージョン、互換性、およびファームウェアアップデート A-3
A.3 RSLogix Guard PLUS!ソフトウェアと GuardPLCファームウェアの
互換性

A.3.1 RSLogix Guard PLUS!ソフトウェアとそれに関連する
GuardPLCファームウェアバージョン

以下の表に、RSLogix Guard PLUS!ソフトウェアの主要なリリースに関する
ファームウェアバージョンについて説明しています。下位互換性は保持され
るため、初期バージョンの RSLogix Guard PLUS!ソフトウェアを使用して開
発されたユーザプログラムは最近のバージョンの GuardPLCファームウェア
でも動作します。

プログラミングソフトウェアの
バージョン

GuardPLCプラットフォームとファームウェア
バージョン 新しい機能

RSLogix Guard
Project Manager Ver. 3.3 Build 4903
Hardware Manager Ver. 2.2.12

GuardPLC 1200および GuardPLC 2000
シリーズ A CPUファームウェアバージョン 1.04
シリーズ A COMファームウェアバージョン 1.00

GuardPLC 1200および GuardPLC 2000
シリーズ B CPUファームウェアバージョン 2.04
シリーズ B COMファームウェアバージョン 2.80

最初のリリース
　
　

ピア・ツー・ピア通信を追加

RSLogix Guard PLUS!
Project Manager Ver. 3.5 Build 6817
Hardware Manager Ver. 4.0.26

GuardPLC 1200および GuardPLC 2000
シリーズ C CPUファームウェアバージョン 4.32
シリーズ C COMファームウェアバージョン 4.24

GuardPLC 1600および GuardPLC 1800
シリーズ A CPUファームウェアバージョン 4.32
シリーズ A COMファームウェアバージョン 5.14

GuardPLC DIOファームウェア 4.28

GuardPLC Ethernet分散 I/Oモ
ジュールのサポートを追加

GuardPLC 1600および GuardPLC 
1800のサポートを追加

RSLogix Guard PLUS!
Project Manager Ver. 4.0 Build 6104
Hardware Manager Ver. 6.56.0

GuardPLC 1200および GuardPLC 2000
シリーズ C CPUファームウェアバージョン 6.12
シリーズ C COMファームウェアバージョン 8.32

GuardPLC 1600および GuardPLC 1800
シリーズ B CPUファームウェアバージョン 6.12
シリーズ B COMファームウェアバージョン 8.32

GuardPLC DIOファームウェア 6.12

GuardPLC 1200と GuardPLC 2000
は、1753-DNSI DeviceNet Safety
スキャナをサポートしていない。

1753-DNSI DeviceNet Safetyス
キャナのサポートを追加
(GuardPLC 1600および
GuardPLC 1800のみ )

RSLogix Guard PLUS!
Project Manager Ver. 4.1 Build 6111
Hardware Manager Ver. 7.56.10

GuardPLC 1200および GuardPLC 2000
シリーズ C CPUファームウェアバージョン 6.28
シリーズ C COMファームウェアバージョン 8.32

GuardPLC 1600および GuardPLC 1800
シリーズ C CPUファームウェアバージョン 6.28
シリーズ C COMファームウェアバージョン 10.36

GuardPLC DIOファームウェア 6.28

4つの新しい分散 I/Oモジュール
および 1753-HHTハンドヘルド
ターミナルのサポートを追加

GuardPLC 1600および GuardPLC 
1800コントローラに EtherNet/IP
通信を追加
Pub.No. 1753-PM001A-JA-P
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A.3.2 ファームウェアとソフトウェアバージョンの互換性

以下の表に、GuardPLCコントローラおよび分散 I/Oファームウェアと、
RSLogix Guard PLUS!ソフトウェアバージョンの最高の組み合わせの選択を
示します。他の組み合わせを使用した場合、特定の機能のアップグレードを
使用することはできません。

CPU/COM
バージョン

GuardPLCコント
ローラのプラット
フォーム

分散 I/Oファー
ムウェアのバー
ジョン

RSLogix Guard 
PLUS! ソフトウェ
アのバージョン 互換性

CPU 1.04
COM 1.00

1200および 2000 N/A 3.3 Yes

3.5以降 No

CPU 2.04
COM 2.80

1200および 2000 N/A 3.3 Yes

3.5以降 No

CPU 4.32
COM 4.24

1200および 2000 4.28 3.5以降 Yes

CPU 4.32
COM 5.14

1600および 1800 4.28 3.5以降 Yes

CPU 4.32
COM 4.24

1200および 2000 6.12以降 3.5以降 No

CPU 4.32
COM 5.14

1600および 1800 6.12以降 3.5以降 No

CPU 6.12
COM 8.32

1200, 2000, 1600, お
よび 1800

4.28 3.5以降 Yes(1)(2)

(1) CPUファームウェアを Ver.6.28にアップグレードすることをお奨めします。
(2) 分散 I/Oファームウェアを Ver.6.28にアップグレードすることをお奨めします。

CPU 6.12
COM 8.32

1200, 2000, 1600, お
よび 1800

6.12 3.5以降 Yes(1)(2)

CPU 6.12
COM 8.32

1200, 2000, 1600, お
よび 1800

6.28 3.5以降 Yes(1)

CPU 6.28
COM 8.32

1200, 2000, 1600, お
よび 1800

4.28 3.5以降 Yes(2)

CPU 6.28
COM 8.32

1200, 2000, 1600, お
よび 1800

6.12 3.5以降 Yes(2)

CPU 6.28
COM 8.32

1200, 2000, 1600, お
よび 1800

6.28 3.5以降 Yes

CPU 6.28
COM 10.36

1600および 1800 6.12 3.5以降 Yes(2)

CPU 6.28
COM 10.36

1600および 1800 6.28 3.5以降 Yes
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A.4 プロジェクトの変換

既存のプロジェクトをあるソフトウェアバージョンまたはパッケージから他
に変換する手順については、以下の表を参照してください。

A.5 GuardPLCファームウェアのアップグレード

GuardPLCファームウェアは 2つの部分 (CPUと COM)でアップグレードさ
れます。以下の手順に従って、GuardPLCコントローラに現在インストール
されている CPUと COMオペレーティングシステム (OS)のバージョンを判
断してください。

1. GuardPLCコントローラにオンラインにして、Hardware Managementウィ
ンドウの Control Panelを開きます。

2. Control Panelの OSタブを選択します。表に、CPU OSバージョンと
COM OSバージョンがリストされます。

A.5.1 CPUファームウェアのアップグレード

1. Control Panelメニューから、Extra→ Update OS→ Update CPUを順に選
択します。

2. 新しいファームウェアを含むフォルダをブラウズして、適切なファイル
を探します。CPUファームウェアファイルにはファイル名に ‘cpu’が含ま
れ、ファイル拡張子は .ldbです。

3. ファームウェアファイルを選択してから、Openをクリックしてアップグ
レードプロセスを開始します。

変換 手順

変換元： RSLogix Guard Ver. 3.3 RSLogix Guard PLUS!に付属するプロジェクト・
コンバータ・ツールを使用してプロジェクトを
変換する。このツールは、RSLogix Guard Ver.3.3
から RSLogix Guard PLUS! Ver. 3.5への変換にの
み機能する。ツールを動作するには、RSLogix 
Guardと RSLogix Guard PLUS!の両方がコンバー
タツールと同じ PCにインストールされて、適
切なアクティベーションを持っていることが必
要です。

変換先： RSLogix Guard PLUS! 
Ver. 3.5

変換元： RSLogix Guard Ver. 3.3 1. RSLogix Guard Ver. 3.3 から RSLogix Guard 
PLUS! Ver. 3.5に変換する。

2. RSLogix Guard PLUS! Ver. 3.5から RSLogix 
Guard PLUS! Ver. 4.0または Ver. 4.1に変換す
る。

RSLogix Guard PLUS! Ver. 3.5をお持ちではない
ときは、当社までお問い合わせください。

変換先： RSLogix Guard PLUS! 
Ver. 4.0または Ver. 4.1

変換元： RSLogix Guard PLUS! 
Ver. 3.5

1. プロジェクトを Ver. 3.5にアーカイブする。
2. プロジェクトを Ver. 4.0または Ver. 4.1にリス
トアする。

注：Ver. 4.0または Ver. 4.1プロジェクトを Ver. 
3.5に後方変換することはできない。Ver. 3.5プ
ロジェクトにアーカイブしてから Ver. 4.0または
Ver. 4.1にリストアすることで、オリジナルのプ
ロジェクトを保存する。

変換先： RSLogix Guard PLUS! 
Ver. 4.0または v. 4.1
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4. ファームウェアをダウンロードしたら、GuardPLCコントローラがリブー
トします。

次のステップを処理して、COMファームウェアをアップグレードする前
に、リブートが完了するのを待ちます。

A.5.2 COMファームウェアのアップグレード

1. COMファームウェアをアップグレードするには、Control Panel メニュー
ラーから Extra→ Update OS→ Update COMを順に選択します。

2. 新しいファームウェアを含むフォルダをブラウズして、対応するファイ
ルを探します。CPUファームウェアファイルにはファイル名に ‘cpu’が含
まれ、ファイル拡張子は .ldbです。

3. ファームウェアファイルを選択してから、Openをクリックしてアップグ
レードプロセスを開始します。

4. COMをアップグレードしたら、Control Panelがオフラインになります。
Control Panelの左上にある Connectボタンをクリックして、再度オンライ
ンにします。

5. 中間ステップとして Ver. 7.2にアップグレードする場合は、ステップ 2～
4を行なって、希望のバージョンにアップグレードできます。

ヒント
Af

ファームウェアアップグレードが成功すると、Control Panel
の OSタブのバージョンの表に、正しい CPU OSバージョン
番号が示されます。Hardware Managementウィンドウの一番
下にあるログファイルにもアップグレードが成功したこと
が表示されます。

重要 7.0より前の COMファームウェアバージョンから 7.0以降
のバージョンにアップグレードするときは、最初に Ver. 7.2
にアップグレードしてから 8.32などの新しいバージョンに
アップグレードする必要があります。

この中間ステップを実行しない場合、GuardPLCのオペレー
ティングシステムが破壊されることがあります。この中間
ステップで選択するファイルは
‘macom_ha_L2_bs_v7_2_up.ldb’です。

この中間ステップは、7.0以降のバージョンから 7.0より前
のバージョンに後方変換する場合にも必要です。必要な
ファイルは、‘macom_ha_L2_bs_v7_2_down.ldb’です。

ヒント
A

ファームウェアアップグレードが成功すると、Control Panel
の OSタブのバージョンの表に新しい COM OS バージョン
番号が示されます。Hardware Managementウィンドウの一番
下にあるログファイルにもアップグレードが成功したこと
が表示されます。
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A.5.3 SRSのリセット

ファームウェアアップグレードによって SRSがデフォルト値にリセットさ
れるため、ファームウェアアップグレードを完了した後で SRSをオリジナ
ルの値に戻す必要があります。

1. Control Panelメニューから、Extra→ Change System IDを順に選択しま
す。

2. SRSを入力してから、OKをクリックして SRSをリセットします。

重要 コントローラのファームウェアをアップグレードできたら、
RSLogix Guard PLUS!ソフトウェアを適切なバージョンに
アップグレードする必要があります。

前のバージョンの RSLogix Guard PLUS!ソフトウェアで作
成された既存のプロジェクトを開くと、ソフトウェアはプ
ロジェクトを新しいバージョンに自動的に変換します。

古いバージョンの RSLogix Guard PLUS!ソフトウェアで作
成されたプロジェクの既存のバージョントをそのまま保持
したいときは、古いバージョンのソフトウェアを使用して
プロジェクトをアーカイブする必要があります。

新しいバージョンのプロジェクトを古いバージョンのソフ
トウェアに戻すことはできません。
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A-8 プログラミングソフトウェアのバージョン、互換性、およびファームウェアアップデート
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付録 B

GuardPLC OPCサーバの構成

B.1 本付録の内容

OLE for Process Control (OPC)は、異なるアプリケーション間でデータを交換
するための標準インターフェイスです。GuardPLC OPCサーバは、
GuardPLCシステムと OPCインターフェイスのある他のシステムとの間に
Ethernetインターフェイスを提供します。

この付録には、OPCクライアント (この場合は GuardPLC 1600コントロー
ラ )に対してデータを読み書きできるように GuardPLC OPCサーバを構成す
るために必要なステップを説明します。RSLogix Guard PLUS!ソフトウェア
を使用して、トークングループを作成して、OPC サーバとコントローラと
の間に HH ネットワークコネクションを作成します。信号は、このコネク
ションの入力と出力セクションに接続されます。出力セクションに接続され
た信号は、コントローラから OPCサーバに送信されます。入力セクション
に接続された信号は、OPCサーバからコントローラに送信されます。

OPC サーバで使用するための XMLファイルを作成するには、以降のセク
ションに詳細に説明する手順を行なってください。

• OPCサーバの IPアドレスを選択する。

• コントローラと OPCサーバを RSLogix Guard PLUS!プロジェクトに追加
する。

• GuardPLCシステムを OPC通信用に構成する。

•  XMLコードを OPCサーバ用に生成する。

B.2 IPアドレスの選択

OPCサーバと GuardPLCコントローラの IPアドレスを選択します。この例
では、GuardPLCコントローラのデフォルトの IPアドレスである
192.168.0.99を使用しています。OPCサーバの IPアドレスは 192.168.0.216
です。

内容 参照ページ

IPアドレスの選択 B-1

GuardPLCコントローラと OPCサーバのプロジェクトへの追加 B-2

GuardPLCシステムの OPC通信用の構成 B-3

OPCサーバ用のコードの生成 B-7

コントローラに対してオンラインにする B-7

OPCサーバの使用 B-8
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B-2 GuardPLC OPCサーバの構成
B.3 GuardPLCコントローラと OPCサーバのプロジェクトへの追加 

1. RSLogix Guard PLUS!ソフトウェアで、Project→ Newを順に選択します。

2. プロジェクトの名前を入力してから、OKを押して確定します。この例
では、プロジェクトは ‘OPCtest’と呼ばれています。

3. Hardware Managementウィンドウで、Resourceが表示されるまで
Configurationを展開します。

この例では、リソースの名前を G16OPC01に変更します。リソースの名
前を変更する必要はありません。

4. G16OPC01を右クリックしてから、Propertiesを選択します。

5. SRSを 60000に、および Typeを使用するコントローラに変更します。こ
の例では、GuardPLC 1600コントローラを使用しています。

6. Applyを押して、残りのチェックボックスをチェックします。

7. OKをクリックします。
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GuardPLC OPCサーバの構成 B-3
8. プロジェクトツリーで Configurationを右クリックしてから、New→
OPC-Serverを順に選択します。OPCサーバがプロジェクトツリーに表示
されます。

B.4 GuardPLCシステムの OPC通信用の構成

B.4.1 通信ネットワークの構成

1. Hardware Managementウィンドウで、OPCtest Projectを右クリックしてか
ら、New→ HH-Networkを順に選択します。

2. HH-Networkを展開します。

3. Token Groupを右クリックしてから、Node Editorを選択します。

4. OPC-Serverと G16OPC01を Node Editorにドラッグします。

5. Node Editorを閉じます。

6. OPC-Serverを右クリックしてから、Editを選択します。
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B-4 GuardPLC OPCサーバの構成
7. G16OPC01を OPC-Server Resources Editorにドラッグします。

Specify HH-Network Configuration for OPCダイアログを開きます。

8. OKをクリックします。

B.4.2 信号の接続

1. メニューバーから Signalsプルダウンメニューを選択してから、Editorを
選択します。

2. 2つの新しい信号を追加します。

• DI1：入力は OPCサーバに送信する。

• DO1：出力は OPCサーバから送信される。

3. OPC-Server Resources Editorで 1を左クリックします。Connect 
OPC-Signalsを選択します。

4. Signal Editorから OPC Signal Connectionsウィンドウの Inputsセクション
に DO1をドラッグします。

5. Outputsタブを選択します。Signal Editorから OPC Signal Connectionsウィ
ンドウの Outputsセクションに DI1をドラッグします。

6. OPC Signal Connectionsウィンドウと OPC-Server Resources Editorを閉じ
ます。

ヒント Inputと Outputは、コントローラとそれぞれ同じです。この
場合、出力は GuardPLC 1600コントローラから送信される
信号で、入力は GuardPLC 1600コントローラに送信される
信号のことです。
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GuardPLC OPCサーバの構成 B-5
7. G16OPC01ツリーを完全に展開します。[1] DI 20を右クリックしてから、
Connect Signalsを選択します。

8. Signal Editorから DI[01].Value Signalフィールドに DI1をドラッグしま
す。

9. DI1 Signal Connectionsウィンドウを閉じます。

10. [2] DO 8を右クリックしてから、Connect Signalsを選択します。

11. Outputsタブを選択します。

12.Signal Editorから DO[01].Value signalフィールドに DO1をドラッグしま
す。

13.DO Signal Connectionsウィンドウと Signal Editorを閉じます。

B.4.3 システムプロパティの設定

コントローラ

1. GuardPLC 1600コントローラツリーの下の COMを右クリックしてから、
Propertiesを選択します。

2. IP Addressを 192.168.0.99に設定してから、OKをクリックします。

3. Programming Terminalを右クリックしてから、Propertiesを選択します。
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B-6 GuardPLC OPCサーバの構成
4. System ID (SRS)を 5に設定してから、OKをクリックします。

5. OPC-Serverを右クリックしてから、Propertiesを選択します。

6. System ID (SRS)を 1に設定してから、OKをクリックします。

7. OPC-Serverを展開してから、IP Addressをダブルクリックします。

8. IP Addressを 192.168.0.216に設定してから、OKをクリックします。

トークングループ

1. Token Groupを右クリックしてから、Propertiesを選択します。

2. プロファイルをMediumに変更します。

3. Token Group IDが 4であることを確認します。

ヒント システムには、以下の 3つのデバイスがあります。

• Signal Editorが稼動する PC

• OPCサーバ

• GuardPLCコントローラ

すべてに固有の SRS番号が必要です。
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GuardPLC OPCサーバの構成 B-7
4. Applyをクリックしてから OKをクリックします。

B.5 OPCサーバ用のコードの生成

1. OPCサーバ用に XMLファイルを生成するには、OPC Serverを右クリッ
クしてから Code Generatorを選択します。

プロセスには 1または 2 secしかかかりません。警告またはエラーが起
こっていないことを確認します。

2. 結果として生成された XMLファイルは RSLogix Guard PLUS!プロジェク
トのプロジェクトパスに置かれます。GuardPLC OPCサーバからポイン
トできるようにこのパスをメモしておいてください。

3. Project Managementウィンドウに戻って、プロジェクトを保存します。

4. Configurationを右クリックしてから、Code Generationを選択します。
Error State Viewerをチェックして、エラーまたは警告がないことを確認
します。エラーが表示された場合は解消します。

B.6 コントローラに対してオンラインにする

1. Hardware Managementウィンドウに戻って、プロジェクトをコントロー
ラにダウンロードします。

2. コントローラを RUNモードにします。

3. RSLogix Guard PLUS!ソフトウェアを最小化します。
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B-8 GuardPLC OPCサーバの構成
B.7 OPCサーバの使用

1. Start→ Programs→ RSLogix Guard PLUS→ GuardPLC OPC Serverを順に
選択して、GuardPLC OPC Serverを起動します。

2. File → Openを順に選択します。

3. opc.xmlファイルにカーソルを合わせてから、Openをクリックします。

4. コントローラと OPCサーバが、Rootウィンドウに表示されるはずです。

5. Connect to HIPROボタン をクリックします。

6. クエリに対して Yesと答えます。

7. G16OPC01と OPC Server間のコネクションを開きます。

8. 構造表示で、Rootを展開します。

9. G16OPC01を展開します。

10.Export and Importアイコンを使用して、入力 (DI1)と出力 (DO1) データを
ぞれぞれを表示します。

ルート

名称 システム ID/SRS コネクション状態 IPアドレス

G16OPC01 60000.1 接続されていない。 192.168.0.99, 127.0.0.1

OPC Server_1 1 接続されていない。 192.168.0.216, 127.0.0.1

ルート

名称 システム ID/SRS コネクション状態 IPアドレス

G16OPC01 60000.1 チャネル 1に接続 192.168.0.99, 127.0.0.1

OPC Server_1 1 チャネル 1に接続 192.168.0.216, 127.0.0.1
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付録 C

時間ベースの変数の作成

タイマ変数を作成するには、valueフィールドを作成して、時間の値を入力
してから、そのフィールドをファンクションブロックに接続する必要があり
ます。

1. Function Block Diagram Editorで、ページのオープンスペースを右クリッ
クしてから Create Value Fieldを選択します。

2. カーソルを valueフィールドの位置に移動します。

3. valueフィールドを配置したい場所をクリックします。

4. T#で始まるタイマ値を入力します。

時間の値は、日 (d), 時間 (h), 分 (m), 秒 (s), およびミリ秒 (msec)で入力で
きます。

タイマ値の例 説明

T#14.7h 14.7時間

T#10ms 10msec

T#23h17m 23時間と 17分

T#5d13h45m6s7.8ms 5日、13時間、45分、6秒、および 7.8msec
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Notes:
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